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Introduction

The Automated Acceptance Test Procedure (ATP) allows Cellular Field
Engineers (CFEs) to run automated acceptance tests on all equipped BTS
subsystem devices using the Local Maintenance Facility (LMF) and
supported test equipment per the current Cell Site Data File (CDF)
assignment.

The results of these tests (at the option of the operator) are written to a
file that can be printed. All tests are controlled from the LMF platform
using the GPIB interface, therefore, only recommended test equipment
supported by the LMF can be used.

This chapter describes the tests run from the GUI environment, which is
the recommended method. The GUI provides the advantages of
simplifying the LMF user interface, reducing the potential for miskeying
commmands and associated parameters, and speeding up the execution
of complex operations involving multiple command strings. If you feel
the command line interface (CLI) will provide additional insight into the
progress of ATPs and problems that could possibly be encountered, refer
to LMF CLI Commands, R15.X (68P09251A59).

Before performing any tests, use an editor to view the
“CAVEATS” section of the “readme.txt” file in the c:\wlmf
folder for any applicable information.

The ATP test is to be performed on out-of-service (OOS)
sectors only.

DO NOT substitute test equipment not supported by the
LMF.

IMPORTANT

*

Refer to Chapter 3 for detailed information on test set
connections for calibrating equipment, cables and other test
set components, if required.

NOTE

Customer requirements determine which ATP tests to are to be
performed, and the craftsperson selects the appropriate ATP tests to run.

The tests can be run individually or as one of the following groups:

� All TX: TX tests verify the performance of the BTS transmit line up.
These include the GLI, MCC, BBX, and CIO cards, the LPAs and
passive components including splitters, combiners, bandpass filters,
and RF cables.

� All RX: RX tests verify the performance of the BTS receiver line up.
These include the MPC (for starter frames), EMPC (for expansion
frames), CIO, BBX, MCC, and GLI cards and the passive components
including RX filters (starter frame only), and RF cables.

 . . . continued on next page
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� All TX/RX: Executes all the TX and RX tests.

� Full Optimization: Executes the TX calibration, downloads the BLO,
and executes the TX audit before running all of the TX and RX tests.

ATP Test Prerequisites

Before attempting to run any ATP tests, ensure the following have been
completed:

� BTS has been optimized and calibrated (see Chapter 3).

� LMF is logged into the BTS.

� CSMs, GLIs, BBXs, MCCs, and TSU (if the RFDS is installed) have
correct code load and data load.

� Primary CSM, GLI, and MCCs are INS_ACT.

� BBXs are calibrated and BLOs are downloaded.

� BBXs are OOS_RAM.

� Test cables are calibrated.

� Test equipment is connected for ATP tests (see Figure 3-13 through
Figure 3-16 starting on page 3-50).

� Test equipment has been warmed up 60 minutes and calibrated.

� GPIB is on.

Before performing the FER, be sure that all LPAs are
turned OFF (circuit breakers pulled) or that all transmitter
ports are properly terminated.

All transmit ports must be properly terminated for all ATP
tests.

Failure to observe these warnings may result in bodily
injury or equipment damage.

WARNING

TX OUT Connection

Many of the acceptance test procedures require taking
measurements at the TX OUT (BTS/RFDS) connector. At
sites without RFDS installed, all measurements will be via
the BTS TX OUT connector. At sites with RFDS installed,
all measurements will be via the RFDS directional coupler
TX OUT connector.

IMPORTANT

*
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ATP Test Procedure

There are three different ATP testing options that can be performed to
completely test a BTS. Depending on your requirements, one of the
following ATP testing options should be run.

� ATP Testing Option 1

– All TX/RX

� ATP Testing Option 2

– All TX
– All RX

� ATP Testing Option 3

– TX Mask Test

– Rho Test

– Pilot Time Offset Test

– Code Domain Power Test

– FER Test

The Full Optimization test can be run if you want the TX
path calibrated before all the TX and RX tests are run.

NOTE

If manual testing has been performed with the HP analyzer,
remove the manual control/system memory card from the
card slot and set the I/O Config to the Talk & Lstn mode
before starting the automated testing.

IMPORTANT

*

Follow the procedure in Table 4-1 to perform any ATP test.

The STOP button can be used to stop the testing process.

NOTE

Table 4-1: ATP Test Procedure

� Step Action

1 Select the device(s) to be tested.

2 From the Tests menu, select the test you want to run.

3 Select the appropriate carrier(s) (carrier-bts#-sector#-carrier#) displayed in the Channels/Carrier
pick list.

NOTE
To select multiple items, hold down the <Shift> or <Ctrl> key while making the selections.

. . . continued on next page
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Table 4-1: ATP Test Procedure

� ActionStep

4 Enter the appropriate channel number in the Carrier n Channels box.

The default channel number displayed is determined by the CdmaChans[n] number in the
cbsc–n.cdf file for the BTS.

5 Click on the OK button.

The status report window and a Directions pop-up are displayed.

6 Follow the cable connection directions as they are displayed.

The test results are displayed in the status report window.

7 Click on Save Results or Dismiss.

NOTE
If Dismiss is used, the test results will not be saved in the test report file.
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Individual Acceptance Tests

The following individual tests can be used to verify the results of
specific tests.

Spectral Purity TX Mask (Primary & Redundant BBX)

This test verifies that the transmitted CDMA carrier waveform generated
on each sector meets the transmit spectral mask specification with
respect to the assigned CDF file values.

Waveform Quality (rho)

This test verifies that the transmitted Pilot channel element digital
waveform quality (rho) exceeds the minimum specified value in
ANSI–J_STD–019. “Rho” represents the correlation between actual and
perfect CDMA modulation spectrum. A rho value of 1.0000 represents
100% (or perfect correlation).

Pilot Time Offset

The Pilot Time Offset is the difference between the CDMA analyzer
measurement interval (based on the BTS system time reference) and the
incoming block of transmitted data from the BTS (Pilot only, Pilot
Gain = 262, PN Offset = 0).

Code Domain Power (Primary & Redundant BBX)

This test verifies the code domain power levels, which have been set for
all ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that the ratio of PILOT divided by OCNS is equal to
10.2 � 2 dB, and, that the noise floor of all EVEN numbered “OFF”
Walsh channels measures � –27 dB (with respect to total CDMA
channel power).

Frame Error Rate

The Frame Error Rate (FER) test verifies RX operation of the entire
CDMA Reverse Link using all equipped MCCs assigned to all
respective sector/antennas. This test verifies the BTS sensitivity on all
traffic channel elements currently configured on all equipped MCCs at
an RF input level of –119 dBm (or –116 dBm if using TMPC).

4
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Tx Mask Test

This test verifies the spectral purity of each BBX carrier keyed up at a
specific frequency, per the current CDF file assignment. All tests are
performed using the external calibrated test set, controlled by the same
command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

The Pilot Gain is set to 541 for each antenna, and all channel elements
from the MCCs are forward-link disabled. The BBX is keyed up, using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only). BBX power output is set to obtain +40 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler).

TX output power is set to +40 dBm by setting BTS power
level to +33.5 dBm to compensate for 6.5 dB increase from
pilot gain set to 541.

NOTE

The calibrated communications test set measures and returns the
attenuation level of all spurious and IM products in a 30 kHz resolution
bandwidth. With respect to the mean power of the CDMA channel
measured in a 1.23 MHz bandwidth in dB, verify that results meet
system tolerances at the following test points:

� 1.7/1.9 GHz:

– at least –45 dB @ + 900 kHz from center frequency

– at least –45 dB @ – 900 kHz from center frequency

� 800 MHz:

– at least –45 dB @ + 750 kHz from center frequency

– at least –45 dB @ – 750 kHz from center frequency

– at least –60 dB @ – 1980 kHz from center frequency

– at least –60 dB @ – 1980 kHz from center frequency

The BBX then de-keys, and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.
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Figure 4-1: TX Mask Verification Spectrum Analyzer Display
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Rho Test

This test verifies the transmitted Pilot channel element digital waveform
quality of each BBX carrier keyed up at a specific frequency per the
current CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all channel elements
from the MCCs are forward link disabled. The BBX is keyed up using
both bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
channel element digital waveform quality (rho) in dB, verifying that the
result meets system tolerances:

� Waveform quality (rho) should be > 0.912 (–0.4 dB).

The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then be repeated.
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Pilot Offset Acceptance Test

This test verifies the transmitted Pilot channel element Pilot Time Offset
of each BBX carrier keyed up at a specific frequency per the current
CDF file assignment. All tests are performed using the external
calibrated test set controlled by the same command. All measurements
are via the appropriate TX OUT (BTS/RFDS) connector.

The Pilot Gain is set to 262 for each antenna, and all TCH elements from
the MCCs are forward link disabled. The BBX is keyed up, using both
bbxlvl and bay level offsets, to generate a CDMA carrier (with pilot
channel element only, Walsh code 0). BBX power output is set to
40 dBm as measured at the TX OUT connector (on either the BTS or
RFDS directional coupler).

The calibrated communications test set measures and returns the Pilot
Time Offset in µs, verifying results meet system tolerances:

� Pilot Time Offset should be within < 3 µs of the target PT
Offset (0 µs).

The BBX then de-keys, and if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated.
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Code Domain Power Test

This test verifies the Code Domain Power/Noise of each BBX carrier
keyed up at a specific frequency per the current CDF file assignment.
All tests are performed using the external calibrated test set controlled by
the same command. All measurements are via the appropriate TX OUT
(BTS/RFDS) connector.

For each sector/antenna under test, the Pilot Gain is set to 262. All MCC
channel elements under test are configured to generate Orthogonal
Channel Noise Source (OCNS) on different odd Walsh codes and to be
assigned a full–rate gain of 81. The maximum number of MCC/CEs to
be tested an any one time is 32 (32 odd Walsh codes). If more than 32
CEs exist, then multiple sets of measurements are made; so all channel
elements are verified on all sectors.

BBX power output is set to 40 dBm as measured at the TX OUT
connector (on either the BTS or RFDS directional coupler).

You verify the code domain power levels, which have been set for all
ODD numbered Walsh channels, using the OCNS command. This is
done by verifying that Pilot Power (dBm) minus OCNS Power (dBm) is
equal to 10.2 + 2 dB and that the noise floor of all “OFF” Walsh channels
measures  < –27 dB (with respect to total CDMA channel power).

The BBX then de-keys and, if selected, the MCC is re-configured to
assign the applicable redundant BBX to the current TX antenna path
under test. The test is then repeated. Upon completion of the test, OCNS
is disabled on the specified MCC/CE.
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Figure 4-2: Code Domain Power and Noise Floor Levels

Pilot Channel

Active channels

PILOT LEVEL

MAX OCNS SPEC.

MIN OCNS SPEC.

MAXIMUM NOISE FLOOR: 
< –27 dB SPEC.

Inactive channels

Walsh  0  1  2  3  4  5  6  7 ... 64

MAX OCNS
CHANNEL

MIN OCNS
CHANNEL

8.2 dB 12.2 dB

MAX NOISE
FLOOR

Pilot Channel

Active channels

PILOT LEVEL

MAX OCNS SPEC.

MIN OCNS SPEC.

MAXIMUM NOISE FLOOR:
< –27 dB

Inactive channels

Walsh  0  1  2  3  4  5  6  7 ... 64

FAILURE – DOES NOT
MEET MIN OCNS SPEC.

FAILURE – EXCEEDS
MAX OCNS SPEC. 8.2 dB 12.2 dB

FAILURE – EXCEEDS MAX
NOISE FLOOR SPEC.

 Showing all OCNS Passing

 Indicating Failures
FW00283

4



RX Frame Error Rate (FER) Acceptance Test
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FER Test

This test verifies the BTS FER on all traffic channel elements currently
configured on all equipped MCCs (full rate at 1% FER) at an RF input
level of –119 dBm [or –116 dBm if using Tower Top
Amplifier (TMPC)]. All tests are performed using the external calibrated
test set as the signal source controlled by the same command. All
measurements are via the LMF.

The Pilot Gain is set to 262 for each TX antenna, and all channel
elements from the MCCs are forward-link disabled. The BBX is keyed
up, using only bbxlvl level offsets, to generate a CDMA carrier (with
pilot channel element only). BBX power output is set to –20 dBm as
measured at the TX OUT connector (on either the BTS or RFDS
directional coupler). The BBX must be keyed to enable the RX receive
circuitry.

The LMF prompts the MCC/CE under test to measure all zero longcode
and provide the FER report on the selected active MCC on the reverse
link for both the main and diversity RX antenna paths, verifying that
results meet the following specification:

� FER returned less than 1% and total frames measured is 1500

All MCC/CEs selected are tested on the specified RX antenna path. The
BBX then de-keys and, if selected, the MCC is re-configured to assign
the applicable redundant BBX to the current RX antenna paths under
test. The test is then repeated.
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Background

Each time an ATP test is run, an ATP report is updated to include the
results of the most recent ATP tests if the Save Results button is used to
close the status report window. The ATP report is not updated if the
status reports window is closed using the Dismiss button.

ATP Report

Each time an ATP test is run, a separate report is created for each BTS
and includes the following for each test:

� Test name

� BBX number

� Channel number

� Carrier number

� Sector number

� Upper test limit

� Lower test limit

� Test result

� PASS or FAIL

� Description information (if applicable)

� Time stamp

� Details/Warning information (if applicable)

The report can be printed if the LMF computer is connected to a printer.
Follow the procedure in the Table 4-2 to view and/or print the ATP
report for a BTS.

Table 4-2: Generating an ATP Report

� Step Action

1 Click on the Login tab (if not in the forefront).

2 Select the desired BTS from the available Base Station pick list.

3 Click on the Report button.

4 Click on a column heading to sort the report.

5 – If not desiring a printable file copy, click on the Dismiss button.

– If requiring a printable file copy, select the desired file type in the picklist and click on the
Save button.
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Chapter 5: Prepare to Leave the Site
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External Test Equipment
Removal

Perform the procedure in Table 5-1 to disconnect the test equipment and
configure the BTS for active service.

Table 5-1: External Test Equipment Removal

Step Action

1 Disconnect all external test equipment from all TX and RX connectors on the top of the frame.

2 Reconnect and visually inspect all TX and RX antenna feed lines at the top of the frame.

Verify that all sector antenna feed lines are connected to the
correct ports on the frame. Crossed antenna cables will
cause system degradation of call processing.

CAUTION

Each module or device can be in any state prior to
downloading. Each module or device will be in an
OOS_RAM state after downloading has completed.

– For all LMF commands, information in italics
represents valid ranges for that command field.

– Only those fields requiring an input will be specified.
Default values for other fields will be assumed.

– For more complete command examples (including
system response details), refer to the CDMA LMF
User  Guide.

NOTE
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Reset All Devices

Reset all devices by cycling power before leaving the site. The
configuration data and code loads could be different from data and code
on the LMF. By resetting all devices, the CBSC can load the proper data
and code when the span is active again.

Follow the procedure in Table 5-2 as required to bring all processor
modules from the OOS to INS mode.

Have the CBSC/MM bring up the site and enable all
devices at the BTS.

IMPORTANT

*

Table 5-2: Enabling Devices

� Step Action

1 On the LMF, select the device(s) you wish to enable.

NOTE
The MGLI and CSM must be INS before an MCC can be put INS.

2 Click on Device from the menu bar.

3 Click on Enable from the Device menu.

A status report window is displayed.

NOTE
If a BBX2 is selected, a Transceiver Parameters window is displayed to collect keying
information.

Do not enable the BBX2.

4 Click OK to close the Transceiver Parameters window.

A status report window displays the status of the device.

5 Click OK to close the status report window.

The selected devices that successfully change to INS change color to green.
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Re–connect BTS T1 Spans
and Integrated Frame Modem

Before leaving the site, connect any T1 span TELCO connectors that
were removed to allow the LMF to control the BTS. Refer to Table 5-3
and Figure 5-1 as required.

Table 5-3: T1/E1 Span/IFM Connections

Step Action

1 Connect the 50–pin TELCO cables to the BTS span I/O board 50–pin TELCO connectors.

2 If used, connect the dial–up modem RS–232 serial cable to the Site I/O board RS–232 9–pin
sub D connector.

* IMPORTANT
Verify that you connect both SPAN cables (if removed previously), and the Integrated Frame
Modem (IFM) “TELCO” connector.

Figure 5-1: Site and Span I/O Boards T1 Span Connections
50–PIN TELCO
CONNECTORS
REMOVED

SPAN A CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

SPAN B CONNECTOR
(TELCO) INTERFACE
TO SPAN LINES

TOP of Frame
 (Site I/O and Span I/O boards)

RS–232 9–PIN SUB D
CONNECTOR SERIAL
PORT FOR EXTERNAL
DIAL UP MODEM
CONNECTION (IF USED)

FW00299
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BTS Site Span Configuration
Verification

Perform the procedure in Table 5-4 to verify the current Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/SGLI2
boards in all C–CCP shelves that terminate a T1/E1 span should be
verified.

Table 5-4: BTS Span Parameter Configuration

Step Action

1 Connect a serial cable from the LMF COM1 port (via null modem board) to the front panel of the
MGLI2 MMI port (see Figure 5-2).

2 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-5 on page 3-11).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 Enter the following MMI command to display the current MGLI2/SGLI2 framing format and line
code configuration (in bold type):

span view <cr>

Observe a display similar to the options shown below:

COMMAND ACCEPTED: span view

The parameter in NVM is set to T1_2.

The frame format in flash is set to use T1_2.
Equalization:
  Span A – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span B – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span C – Default (0–131 feet for T1/J1, 120 Ohm for E1)

S D D f lt (0 131 f t f T1/J1 120 Oh f E1)  Span D – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span E – Default (0–131 feet for T1/J1, 120 Ohm for E1)
  Span F – Default (0–131 feet for T1/J1, 120 Ohm for E1)

Linkspeed: Default (56K for T1 D4 AMI, 64K otherwise)
Currently, the link is running at the default rate 
The actual rate is 0

NOTE
Defaults for span equalization are 0–131 feet for T1/J1 spans and 120 Ohm for E1.

Default linkspeed is 56K for T1 D4 AMI spans and 64K for all other types.

There is no need to change from defaults unless the OMC–R/CBSC span configuration requires it.

If the current MGLI2/SGLI2 framing format and line code configuration does not display the correct
choice, proceed to Table 5-5.
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Table 5-4: BTS Span Parameter Configuration

Step Action

4 Repeat steps 1 through 3 for all remaining GLIs.

5 Exit the GLI MMI session and HyperTerminal connection by selecting File from the connection
window menu bar, and then Exit from the dropdown menu.

ÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂ
ÂÂÂÂÂÂÂ

Á Á

Á

ÁÁÁÁ

Á

FW00344

9–PIN TO 9– PIN
RS–232 CABLE

NULL MODEM BOARD
(PART# 8484877P01)

RS–232 CABLE 
FROM LMF COM1
PORT

MMI SERIAL PORT

GLI BOARD

Figure 5-2: MGLI2/SGLI2 MMI Port Connection

Set BTS Site Span
Configuration

Perform the procedure in Table 5-5 to configure the Span Framing
Format and Line Build Out (LBO) parameters. ALL MGLI2/SGLI2
boards in all C–CCP shelves that terminate a T1/E1 span must be
configured.

Perform the following procedure ONLY if span
configurations loaded in the MGLI2/GLI2s do not match
those in the OMCR/CBSC data base, AND ONLY when the
exact configuration data is available. Loading incorrect
span configuration data will render the site inoperable.

IMPORTANT

*
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

1 If not already done, connect a serial cable from the LMF COM1 port (via null modem board) to the
front panel of the MGLI2 MMI port (see Figure 5-2).

2 Start an MMI communication session with CSM–1 by using the Windows desktop shortcut icon (see
Table 3-5 on page 3-11).

NOTE
The LMF program must not be running when a Hyperterminal session is started if COM1 is being
used for the MMI session.

3 If required only, enter the following MMI command for each span line to set the BTS span parameters
to match that of the physical spans a – f run to the site:

span_config <option#1> <option#2> <option#3> <option#4> <option#5>
option#1   =  the span to change (a – f)
option#2   =  the span type (0 – 8):

0 – E1_1 (HDB3, CCS, CRC–4)
1 – E1_2 (HDB3, CCS)
2 – E1_3 (HDB3, CAS, CRC–4, TS16)
3 – E1_4 (HDB3, CAS, TS16)
4 – T1_1 (AMI, DS1 AT&T D4, without ZCS, 3 to 1 packing, Group 0 unusable)
5 – T1_2 (B8ZS, DS1 AT&T ESF, 4 to 1 packing, 64K link)
6 – J1_1 (B8ZS, J1 AT&T ESF, Japan CRC6, 4 to 1 packing)
7 – J1_2 (B8ZS, J1 AT&T ESF, US CRC6, 4 to 1 packing)
8 – T1_3 (AMI, DS1 AT&T D4, with ZCS, 3 to 1 packing, Group 0 unusable)

option#3   =  the link speed (56 or 64) Kbps

option#4   =  the span equalization (0 – 7):
0 – T1_6 (T1,J1:long haul)
1 – T1_4 (T1,J1:393–524 feet)
2 – T1_4 (T1,J1:131–262 feet)
3 – E1_75 (E1:75 Ohm)
4 – T1_4 (T1,J1:0–131 feet)
5 – T1_4 (T1,J1:524–655 feet)
6 – T1_4 (T1,J1:262–393 feet)
7 – E1_120 (E1:120 Ohm)

option#5   =  the slot that has LAPD channel (0 – 31)

Example for setting span configuration to E1_2, 64 Kbps, E1_120–Ohm, LAPD channel 1:

span_config a 1 64 7 1
.
.

span_config f 1 64 7 1

Example for setting span configuration to T1_2, 64 Kbps, T1_4 (0–131 feet), LAPD channel 0:

span_config a 5 64 4 0
.
.

span_config f 5 64 4 0
. . . continued on next page
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Table 5-5: Set BTS Span Parameter Configuration

Step Action

* IMPORTANT
Make sure that spans a – f are set to the same span type and link speed. The equalization may be
different for each individual span.

After executing the span_config command, the affected MGLI2/SGLI2 board MUST be reset and
re–loaded for changes to take effect.

Although defaults are shown, always consult site specific documentation for span type and rate used at
the site.

4 Press the RESET button on the GLI2 for changes to take effect.

5 This completes the site specific BTS Span setup for this GLI. Move the MMI cable to the next SGLI2
and repeat steps 1 and 4 for ALL MGLI2/SGLI2 boards.

6 Terminate the Hyperterm session and disconnect the LMF from the MGLI/SGLI.
 

Updating CBSC LMF Files

Updated calibration (CAL) file information must be moved from the
LMF Windows environment back to the CBSC, which resides in a Unix
environment. The procedures that follow detail how to move files from
one environment to the other.

Backup CAL Data to a Diskette

The BLO calibration files should be backed up to a diskette (per BTS).
Follow the procedure in Table 5-6 to copy CAL files from a CDMA
LMF computer to a diskette.

Table 5-6: Backup CAL Data to a Diskette

� Step Action

1 Insert a diskette into the LMF A drive.

NOTE
If your diskette has not been formatted, format it using Windows. The diskette must be DOS
formatted before copying any files. Consult your Windows/DOS documentation or on–line help
on how to format diskettes.

2 Click on the Start button and launch the Windows Explorer program from the Programs menu.

3 Click on your C: drive.

4 Double Click on the wlmf folder.

5 Double Click on the CDMA folder.

6 Click on the bts–# folder for the calibration file you want to copy.

7 Drag the BTS–#.cal file to the 3–1/2 floppy (A:) icon on the top left of the screen and release the
mouse button.

8 Repeat steps 6 and 7 until you have copied each file desired.

9 Close the Windows Explorer program by selecting Close from the File menu option.
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LMF Removal

DO NOT power down the LMF without performing the
procedure indicated below. Corrupted/lost data files may
result, and in some cases, the LMF may lock up.

CAUTION

Follow the procedure in Table 5-7 to terminate the LMF session and
remove the terminal.

Table 5-7: LMF Termination and Removal

� Step Action

1 From the CDMA window select File>Exit.

2 From the Windows Task Bar click Start>Shutdown.

Click Yes when the Shut Down Windows message appears.

3 Disconnect the LMF terminal Ethernet connector from the BTS cabinet.

4 Disconnect the LMF serial port, the RS-232 to GPIB interface box, and the GPIB cables as
required for equipment transport.

Copying CAL Files from Diskette to the CBSC

Follow the procedure in Table 5-8 to copy CAL files from a diskette to
the CBSC.

Table 5-8: Procedures to Copy CAL Files from Diskette to the CBSC

� Step Action

1 Login to the CBSC on the workstation using your account name and password.

NOTE
Enter the information that appears in bold text.

2 Place your diskette containing CAL file(s) in the CBSC workstation diskette drive.

3 Type eject –q and press the <Enter> key.

4 Type mount and press the <Enter> key.

Verify that floppy/no_name  is displayed.

NOTE
If the eject command has been previously entered, floppy/no_name  will be appended with a
number. Use the explicit floppy/no_name  reference displayed.

5 Enter cd /floppy/no_name and press the <Enter> key.

6 Enter ls –lia and press the <Enter> key.
Verify that the bts–#.cal file is on the diskette.

7 Enter cd and press the <Enter> key.

. . . continued on next page
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Table 5-8: Procedures to Copy CAL Files from Diskette to the CBSC

� ActionStep

8 Enter pwd and press the <Enter> key.

Verify that you are in your home directory (/home/<name>).

9 Enter dos2unix /floppy/no_name/bts–#.cal  bts–#.cal and press the <Enter> key (where # is the
BTS number).

10 Enter ls –l *.cal and press the <Enter> key.

Verify that the CAL file was successfully copied.

11 Type eject and press the <Enter> key.

12 Remove the diskette from the workstation.

 

Re–establish OMC–R Control/
Verifying T1/E1

After all activities at the site have been completed, and
after disconnecting the LMF, place a phone call to the
OMC–R and request the BTS be placed under control of
the OMC–R.

IMPORTANT

*
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Notes
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Chapter 6: Basic Troubleshooting

Table of Contents

Basic Troubleshooting Overview 6-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Overview 6-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Installation 6-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Log into Cell-Site 6-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Communicate to Power Meter 6-2. . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Communicate to Communications Analyzer 6-3. . . . . . . . . . . . . . 

Troubleshooting: Download 6-4. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Download CODE to Any Device (card) 6-4. . . . . . . . . . . . . . . . . . 
Cannot Download DATA to Any Device (Card) 6-4. . . . . . . . . . . . . . . . . . 
Cannot ENABLE Device 6-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Miscellaneous Errors 6-5. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Calibration 6-6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Bay Level Offset Calibration Failure 6-6. . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Load BLO 6-7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Calibration Audit Failure 6-7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Transmit ATP 6-8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Perform TX Mask Measurement 6-8. . . . . . . . . . . . . . . . . . . . . . . . 
Cannot Perform Rho or Pilot Time Offset Measurement 6-8. . . . . . . . . . . 
Cannot Perform Code Domain Power and Noise Floor Measurement 6-9. 
Cannot Perform Carrier Measurement 6-9. . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: Receive ATP 6-10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Multi–FER Test Failure 6-10. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Troubleshooting: CSM Checklist 6-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Problem Description 6-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Intermittent 19.6608 MHz Reference Clock/GPS Receiver Operation 6-11. 
No GPS Reference Source 6-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Checksum Failure 6-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
GPS Bad RX Message Type 6-11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
CSM Reference Source Configuration Error 6-11. . . . . . . . . . . . . . . . . . . . . 
Takes Too Long for CSM to Come INS 6-12. . . . . . . . . . . . . . . . . . . . . . . . 

C–CCP Backplane Troubleshooting 6-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Introduction 6-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Connector Functionality 6-13. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
C–CCP Backplane Troubleshooting Procedure 6-14. . . . . . . . . . . . . . . . . . . 
Digital Control Problems 6-15. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6



Table of Contents  – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001

DC Power Problems 6-18. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
TX and RX Signal Routing Problems 6-19. . . . . . . . . . . . . . . . . . . . . . . . . . 

Module Front Panel LED Indicators and Connectors 6-20. . . . . . . . . . . . . . . . . . . . . 
Module Status Indicators 6-20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
LED Status Combinations for All Modules (except
GLI2, CSM, BBX2, MCC24, MCC8E) 6-20. . . . . . . . . . . . . . . . . . . . . . . . 
DC/DC Converter LED Status Combinations 6-20. . . . . . . . . . . . . . . . . . . . 
CSM LED Status Combinations 6-21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
GLI2 LED Status Combinations 6-23. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
GLI2 Pushbuttons and Connectors 6-24. . . . . . . . . . . . . . . . . . . . . . . . . . . . 
BBX2 LED Status Combinations 6-25. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
MCC24/8E LED Status Combinations 6-25. . . . . . . . . . . . . . . . . . . . . . . . . 
LPA Shelf LED Status Combinations 6-26. . . . . . . . . . . . . . . . . . . . . . . . . . 

Basic Troubleshooting – Span Control Link 6-27. . . . . . . . . . . . . . . . . . . . . . . . . . . 
Span Problems (No Control Link) 6-27. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6



Basic Troubleshooting Overview

Mar 2001 6-1SC�4812T CDMA BTS Optimization/ATP
DRAFT

Overview

The information in this section addresses some of the scenarios likely to
be encountered by Cellular Field Engineering (CFE) team members.
This troubleshooting guide was created as an interim reference document
for use in the field. It provides basic “what to do if” basic
troubleshooting suggestions when the BTS equipment does not perform
per the procedure documented in the manual.

Comments are consolidated from inputs provided by CFEs in the field
and information gained form experience in Motorola labs and
classrooms.
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Cannot Log into Cell-Site

Follow the procedure in Table 6-1 to troubleshoot a login failure.

Table 6-1: Login Failure Troubleshooting Procedures

� Step Action

1 If MGLI2 LED is solid RED, it implies a hardware failure. Reset MGLI2 by re-seating it. If this
persists, install a known good MGLI2 card in MGLI2 slot and retry. A Red LED may also indicate
no Ethernet termination at top of frame.

2 Verify that T1 is disconnected (see Table 3-1 on page 3-4).

If T1 is still connected, verify the CBSC has disabled the BTS.

3 Try pinging the MGLI2 (see Table 3-6 on page 3-15).

4 Verify the LMF is connected to the Primary LMF port (LAN A) in the front of the BTS (see
Table 3-2 on page 3-5).

5 Verify the LMF was configured properly (see Preparing the LMF section starting on page 3–6).

6 Verify the BTS-LMF cable is RG-58 [flexible black cable of less than 76 cm (2.5 feet) length].

7 Verify the Ethernet ports are terminated properly (see Figure 3-4 on page 3-14).

8 Verify a T-adapter is not used on the LMF side port if connected to the BTS front LMF primary
port.

9 Try connecting to the I/O panel (top of frame). Use BNC T-adapters at the LMF port for this
connection.

10 Re-boot the LMF and retry.

11 Re-seat the MGLI2 and retry.

12 Verify IP addresses are configured properly.

Cannot Communicate to
Power Meter

Follow the procedure in Table 6-2 to troubleshoot a power meter
communication failure.

Table 6-2:  Troubleshooting a Power Meter Communication Failure

� Step Action

1 Verify the Power Meter is connected to the LMF with a GPIB adapter.

2 Verify the cable setup as specified in Chapter 3.

3 Verify the GPIB address of the Power Meter is set to 13.

4 Verify the GPIB adapter DIP switch settings are correct.

Refer to the Test Equipment setup section for details.

. . . continued on next page
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Table 6-2:  Troubleshooting a Power Meter Communication Failure

� ActionStep

5 Verify the GPIB adapter is not locked up. Under normal conditions, only two green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then power-cycle the GPIB Box
and retry.

6 Verify that the Com1 port is not used by another application.

7 Verify that the communications analyzer is in Talk&Listen, not Control mode.

 

Cannot Communicate to
Communications Analyzer

Follow the procedure in Table 6-3 to troubleshoot a communications
analyzer communication failure.

Table 6-3:  Troubleshooting a Communications Analyzer Communication Failure

� Step Action

1 Verify the analyzer is connected to the LMF with GPIB adapter.

2 Verify the cable setup.

3 Verify the GPIB address is set to 18.

4 Verify the GPIB adapter DIP switch settings are correct.

Refer to the Test Equipment setup section starting on page 3–34 for details.

5 Verify the GPIB adapter is not locked up. Under normal conditions, only 2 green LEDs must be
‘ON’ (Power and Ready). If any other LED is continuously ‘ON’, then power-cycle the GPIB Box
and retry.

6 Verify that the Com1 port is not used by another application.

7 If a Hyperterm window is open for MMI, close it.
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Cannot Download CODE to
Any Device (card)

Follow the procedure in Table 6-4 to troubleshoot a code download
failure.

Table 6-4: Troubleshooting Code Download Failure

� Step Action

1 Verify T1 is disconnected from the BTS.

2 Verify the LMF can communicate with the BTS device using the Status function.

3 Communication to the MGLI2 must first be established before trying to talk to any other BTS
device.
The MGLI2 must be INS_ACT state (green).

4 Verify the card is physically present in the cage and powered-up.

5 If the card LED is solid RED, it implies hardware failure.
Reset the card by re-seating it.
If the LED remains solid red, replace with a card from another slot & retry.

NOTE
The card can only be replaced by a card of the same type.

6 Re-seat the card and try again.

7 If BBX reports a failure message and is OOS_RAM, the code load was OK.

8 If the download portion completes and the reset portion fails, reset the device by selecting the
device and Reset.

Cannot Download DATA to
Any Device (Card)

Perform the procedure in Table 6-5 to troubleshoot a data download
failure.

Table 6-5: Troubleshooting Data Download Failure

� Step Action

1 Re-seat the card and repeat code and data load procedure.
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Cannot ENABLE Device

Before a device can be enabled (placed in-service), it must be in the
OOS_RAM state (yellow) with data downloaded to the device. The color
of the device changes to green once it is enabled.

The three states that devices can be changed to are as follows:

� Enabled (green, INS)

� Disabled (yellow, OOS_RAM)

� Reset (blue, OOS_ROM)

Follow the procedure in Table 6-6 to troubleshoot a device enable
failure.

Table 6-6: Troubleshooting Device Enable (INS) Failure

� Step Action

1 Re-seat the card and repeat the code and data load procedure.

2 If the CSM cannot be enabled, verify the CDF file has correct latitude and longitude data for cell
site location and GPS sync.

3 Ensure the primary CSM is in INS_ACT state.

NOTE
MCCs will not go INS without the CSM being INS.

4 Verify the 19.6608 MHz CSM clock; MCCs will not go INS otherwise.

5 The BBX should not be enabled for ATP tests.

6 If MCCs give “invalid or no system time”, verify the CSM is operable.

 

Miscellaneous Errors

Perform the procedure in Table 6-7 to troubleshoot miscellaneous
failures.

Table 6-7: Miscellaneous Failures

� Step Action

1 If LPAs continue to give alarms, even after cycling power at the circuit breakers, then connect an
MMI cable to the LPA and set up a Hyperterminal connection (see Table 3-5 on page 3-11).

2 Enter ALARMS in the Hyperterminal window.
The resulting LMF display may provide an indication of the problem.
(Call Field Support for further assistance.)
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Bay Level Offset Calibration
Failure

Perform the procedure in Table 6-8 to troubleshoot a BLO calibration
failure.

Table 6-8: Troubleshooting BLO Calibration Failure

� Step Action

1 Verify the Power Meter is configured correctly (see the test equipment setup section in Chapter 3)
and connection is made to the proper TX port.

2 Verify the parameters in the bts–#.cdf file are set correctly for the following bands:

For 1900 MHz:
Bandclass=1; Freq_Band=16; SSType=16
For 800 MHz:
Bandclass=0; Freq_Band=8; SSType=8
For 1700 MHz:
Bandclass=4; Freq_Band=128; SSType=16

3 Verify that no LPA in the sector is in alarm state (flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.

4 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.

5 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be ‘ON’ (Power and Ready).
If any other LED is continuously ‘ON’, power-cycle (turn power off and on) the GPIB Box and
retry.

6 Verify the sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power Ref
signal.

7 If communication between the LMF and Power Meter is operational, the Meter display will show
“RES”.
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Cannot Load BLO

For Load BLO failures see Table 6-7.

Calibration Audit Failure

Follow the procedure in Table 6-9 to troubleshoot a calibration audit
failure.

Table 6-9: Troubleshooting Calibration Audit Failure

� Step Action

1 Verify the Power Meter is configured correctly (refer to the test equipment setup section of
Chapter  3).

2 Re-calibrate the Power Meter and verify it is calibrated correctly with cal factors from the sensor
head.

3 Verify that no LPA is in alarm state (rapidly flashing red LED).
Reset the LPA by pulling the circuit breaker and, after 5 seconds, pushing back in.

4 Verify that no sensor head is functioning properly by checking it with the 1 mW (0 dBm) Power
Ref signal.

5 After calibration, the BLO data must be re-loaded to the BBXs before auditing.
Click on the BBX(s) and select Device>Download BLO.
Re-try the audit.

6 Verify the GPIB adapter is not locked up.
Under normal conditions, only two green LEDs must be “ON” (Power and Ready).
If any other LED is continuously “ON”, power-cycle (turn power off and on) the GPIB Box and
retry.
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Cannot Perform TX Mask
Measurement

Follow the procedure in Table 6-10 to troubleshoot a TX mask
measurement failure.

Table 6-10: Troubleshooting TX Mask Measurement Failure

� Step Action

1 Verify that TX audit passes for the BBX(s).

2 If performing manual measurement, verify analyzer setup.

3 Verify that no LPA in the sector is in alarm state (flashing red LED).
Re-set the LPA by pulling the circuit breaker and, after 5 seconds, pushing it back in.

Cannot Perform Rho or Pilot
Time Offset Measurement

Follow the procedure in Table 6-11 to troubleshoot a rho or pilot time
offset measurement failure.

Table 6-11: Troubleshooting Rho and Pilot Time Offset Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offsets displayed on the analyzer is the same as the PN offset in the CDF file.

3 Re–load BBX data and repeat the test.

4 If performing manual measurement, verify analyzer setup.

5 Verify that no LPA in the sector is in alarm state (flashing red LED). Reset the LPA by pulling the
circuit breaker and, after 5 seconds, pushing back in.

6 If Rho value is unstable and varies considerably (e.g. .95,.92,.93), this may indicate that the GPS
is still phasing (i.e., trying to reach and maintain 0 freq. error).
Go to the freq. bar in the upper right corner of the Rho meter and select Hz. Press <Shift–avg>
and enter 10, to obtain an average Rho value. This is an indication the GPS has not stabilized
before going INS and may need to be re-initialized.

 

6



Troubleshooting – Transmit ATP – continued

Mar 2001 6-9SC�4812T CDMA BTS Optimization/ATP DRAFT

Cannot Perform Code Domain
Power and Noise Floor
Measurement

Perform the procedure in Table 6-12 to troubleshoot a code domain and
noise floor measurement failure.

Table 6-12: Troubleshooting Code Domain Power and Noise Floor Measurement Failure

� Step Action

1 Verify presence of RF signal by switching to spectrum analyzer screen.

2 Verify PN offset displayed on analyzer is same as PN offset being used in the CDF file.

3 Disable and re-enable MCC (one or more MCCs based on extent of failure).

 

Cannot Perform Carrier
Measurement

Perform the procedure in Table 6-13 to troubleshoot a carrier
measurement failure.

Table 6-13: Troubleshooting Carrier Measurement Failure

� Step Action

1 Perform the test manually, using the spread CDMA signal.

2 Verify High Stability 10 MHz Rubidium Standard is warmed up (60 minutes) and properly
connected to test set-up.
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Multi–FER Test Failure

Perform the procedure in Table 6-14 to troubleshoot a Multi–FER
failure.

Table 6-14: Troubleshooting Multi-FER Failure

� Step Action

1 Verify the test equipment set up is correct for an FER test.

2 Verify the test equipment is locked to 19.6608 and even second clocks.

On the HP8921A test set, the yellow LED (REF UNLOCK) must be OFF.

3 Verify the MCCs have been loaded with data and are INS–ACT.

4 Disable and re-enable the MCC (one or more based on extent of failure).

5 Disable, re-load code and data, and re-enable the MCC (one or more MCCs based on extent of
failure).

6 Verify the antenna connections to frame are correct based on the directions messages.
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Problem Description

Many of the Clock Synchronization Manager (CSM) board failures may
be resolved in the field before sending the boards to the factory for
repair. This section describes known CSM problems identified in field
returns, some of which are field-repairable. Check these problems before
returning suspect CSM boards.

Intermittent 19.6608 MHz
Reference Clock/GPS
Receiver Operation

If having any problems with CSM board kit numbers, SGLN1145 or
SGLN4132, check the suffix with the kit number. If the kit has version
“AB”, then replace with version “BC” or higher, and return model “AB”
to the repair center.

No GPS Reference Source
Check the CSM boards for proper hardware configuration. CSM kit
SGLN1145, in Slot l, has an on-board GPS receiver; while kit
SGLN4132, in Slot 2, does not have a GPS receiver. Any incorrectly
configured board must be returned to the repair center. Do not attempt to
change hardware configuration in the field. Also, verify the GPS
antenna is not damaged and is installed per recommended guidelines.

Checksum Failure
The CSM could have corrupted data in its firmware resulting in a
non-executable code. The problem is usually caused by either electrical
disturbance or interruption of data during a download. Attempt another
download with no interruptions in the data transfer. Return the CSM
board back to the repair center if the attempt to reload fails.

GPS Bad RX Message Type

This problem is believed to be caused by a later version of CSM
software (3.5 or higher) being downloaded, via LMF, followed by an
earlier version of CSM software (3.4 or lower), being downloaded from
the CBSC. Download again with CSM software code 3.5 or higher.
Return the CSM board back to the repair center if the attempt to reload
fails.

CSM Reference Source
Configuration Error

This problem is caused by incorrect reference source configuration
performed in the field by software download. CSM kits SGLN1145 and
SGLN4132 must have proper reference sources configured (as shown
below) to function correctly.

CSM Kit
No.

Hardware
Configuration

CSM Slot
No.

Reference Source
Configuration

CDF Value

SGLN1145 With GPS Receiver 1 Primary = Local GPS
Backup = Either LFR or HSO

0
2 or 18

SGLN4132 Without GPS Receiver 2 Primary = Remote GPS
Backup = Either LFR or HSO

1
2 or 18
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Takes Too Long for CSM to
Come INS

This problem may be caused by a delay in GPS acquisition. Check the
accuracy flag status and/or current position. Refer to the GSM system
time/GPS and LFR/HSO verification section in Chapter 3. At least one
satellite should be visible and tracked for the “surveyed” mode and four
satellites should be visible and tracked for the “estimated” mode. Also,
verify correct base site position data used in “surveyed” mode.
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Introduction

The C–CCP backplane is a multi–layer board that interconnects all the
C–CCP modules. The complexity of this board lends itself to possible
improper diagnoses when problems occur.

Connector Functionality

The following connector overview describes the major types of
backplane connectors along with the functionality of each. This
information allows the CFE to:

� Determine which connector(s) is associated with a specific problem
type.

� Isolate problems to a specific cable or connector.

Primary “A” and Redundant “B” Inter Shelf Bus Connectors

The 40 pin Inter Shelf Bus (ISB) connectors provide an interface bus
from the master GLI2 to all other GLI2s in the modem frame. Their
basic function is to provide clock synchronization from the master GLI2
to all other GLI2s in the frame.

The ISB also provides the following functions:

� Span line grooming when a single span is used for multiple cages.

� MMI connection to/from the master GLI2 to cell site modem.

� Interface between GLI2s and the AMR (for reporting BTS alarms).

Span Line Connector

The span line input is an 8–pin RJ–45 connector that provides a primary
and secondary (if used) span line interface to each GLI2 in the C–CCP
shelf. The span line is used for MM/EMX switch control of the Master
GLI2 and also all the BBX traffic.

Primary “A” and Redundant “B” Reference Distribution
Module Input/Output

The Reference Distribution Module (RDM) connectors route the 3 MHz
reference signals from the CSMs to the GLI2s and all BBXs in the
backplane. The signals are used to phase lock loop all clock circuits on
the GLI2s and BBX boards to produce precise clock and signal
frequencies.

Power Input (Return A, B, and C connectors)

Provides a +27 volt or –48 volt input for use by the power supply
modules.

 . . . continued on next page
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Power Supply Module Interface

Each power supply module has a series of three different connectors to
provide the needed inputs/outputs to the C–CCP backplane. These
include a VCC/Ground input connector, a Harting style multiple pin
interface, and a +15 V/Analog Ground output connector. The C–CCP
Power Modules convert +27 or –48 Volts to a regulated +15, +6.5, and
+5.0 Volts to be used by the C–CCP shelf cards. In the –48 V BTS, the
LPA power modules convert –48 Volts to a regulated +27 Volts.

GLI2 Connector

This connector consists of a Harting 4SU digital connector and a
6–conductor coaxial connector for RDM distribution. The connectors
provide inputs/outputs for the GLI2s in the C–CCP backplane.

GLI2 Ethernet “A” and “B” Connections

These BNC connectors are located on the C–CCP backplane and routed
to the GLI2 board. This interface provides all the control and data
communications between the master GLI2 and the other GLI2, between
gateways, and for the LMF on the LAN.

BBX Connector

Each BBX connector consists of a Harting 2SU/1SU digital connector
and two 6–conductor coaxial connectors.  These connectors provide DC,
digital, and RF inputs/outputs for the BBXs in the C–CCP backplane.

CIO Connectors

� RX RF antenna path signal inputs are routed through RX Tri–Filters
(on the I/O plate), and via coaxial cables to the two MPC modules –
the six “A” (main) signals go to one MPC; the six “B” (diversity) to
the other. The MPC outputs the low–noise–amplified signals via the
C–CCP backplane to the CIO where the signals are split and sent to
the appropriate BBX.

� A digital bus then routes the baseband signal through the BBX, to the
backplane, then on to the MCC slots.

� Digital TX antenna path signals originate at the MCCs. Each  output
is routed from the MCC slot via the backplane appropriate BBX.

� TX RF path signal originates from the BBX, through the backplane to
the CIO, through the CIO, and via multi-conductor coaxial cabling to
the LPAs in the LPA shelf.

C–CCP Backplane
Troubleshooting Procedure

Table 6-15 through Table 6-24 provide procedures for troubleshooting
problems that appear to be related to a defective C–CCP backplane. The
tables are broken down into possible problems and steps that should be
taken in an attempt to find the root cause.

 . . . continued on next page
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Table 6-15 through Table 6-24 must be completed before
replacing ANY C–CCP backplane.

IMPORTANT

*

Digital Control Problems

No GLI2 Control via LMF (all GLI2s)

Follow the procedure in Table 6-15 to troubleshoot a GLI2 control via
LMF failure.

Table 6-15: No GLI2 Control via LMF (all GLI2s)

� Step Action

1 Check the ethernet for proper connection, damage, shorts, or opens.

2 Verify the C–CCP backplane Shelf ID DIP switch is set correctly.

3 Visually check the master GLI2 connector (both board and backplane) for damage.

4 Replace the master GLI2 with a known good GLI2.

 

No GLI2 Control through Span Line Connection (All GLI2s)

Follow the procedures in Table 6-16 and Table 6-17 to troubleshoot
GLI2 control failures.

Table 6-16: No GLI2 Control through Span Line Connection (Both GLI2s)

Step Action

1 Verify the C–CCP backplane Shelf ID DIP switch is set correctly.

2 Verify that the BTS and GLI2s are correctly configured in the OMCR/CBSC data base.

3 Visually check the master GLI2 connector (both board and backplane) for damage.

4 Replace the master GLI2 with a known good GLI2.

5 Check the span line inputs from the top of the frame to the master GLI2 for proper connection and
damage.

6 Check the span line configuration on the MGLI2 (see Table 5-4 on page 5-4).

Table 6-17: MGLI2 Control Good – No Control over Co–located GLI2

Step Action

1 Verify that the BTS and GLI2s are correctly configured in the OMCR CBSC data base.

2 Check the ethernet for proper connection, damage, shorts, or opens.

3 Visually check all GLI2 connectors (both board and backplane) for damage.

4 Replace the remaining GLI2 with a known good GLI2.
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No AMR Control (MGLI2 good)

Perform the procedure in Table 6-18 to troubleshoot an AMR control
failure when the MGLI control is good.

Table 6-18: MGLI2 Control Good – No Control over AMR

Step Action

1 Visually check the master GLI2 connector (both board and backplane) for damage.

2 Replace the master GLI2 with a known good GLI2.

3 Replace the AMR with a known good AMR.

No BBX Control in the Shelf – (No Control over Co–located
GLI2s)

Perform the procedure in Table 6-19 to troubleshoot a BBX control in
the shelf failure.

Table 6-19: No BBX Control in the Shelf – No Control over Co–located GLI2s

Step Action

1 Visually check all GLI2 connectors (both board and backplane) for damage.

2 Replace the remaining GLI2 with a known good GLI2.

3 Visually check BBX connectors (both board and backplane) for damage.

4 Replace the BBX with a known good BBX.

No (or Missing) Span Line Traffic

Perform the procedure in Table 6-20 to troubleshoot a span line traffic
failure.

Table 6-20: MGLI2 Control Good – No (or Missing) Span Line Traffic

Step Action

1 Visually check all GLI2 connectors (both board and backplane) for damage.

2 Replace the remaining GLI2 with a known good GLI2.

3 Visually check all span line distribution (both connectors and cables) for damage.

4 If the problem seems to be limited to one BBX, replace the MGLI2 with a known good MGLI2.

5 Perform the BTS Span Parameter Configuration ( see Table 5-4 on page 5-4).

6 Ensure that ISB cabling is correct.
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No (or Missing) MCC Channel Elements

Perform the procedure in Table 6-21 to troubleshoot a channel elements
failure.

Table 6-21: No MCC Channel Elements

Step Action

1 Verify CEs on a co–located MCC (MCC24 TYPE=2)

2 If the problem seems to be limited to one MCC, replace the MCC with a known good MCC.

– Check connectors (both board and backplane) for damage.

3 If no CEs on any MCC:

– Verify clock reference to CIO.

4 Check the CDF for MCCTYPE=2 (MCC24) or MCCTYPE=0 (MCC8).
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DC Power Problems

Perform the procedure in Table 6-22 to troubleshoot a DC input voltage
to power supply module failure.

Potentially lethal voltage and current levels are routed to
the BTS equipment. This test must be carried out with a
second person present, acting in a safety role. Remove all
rings, jewelry, and wrist watches prior to beginning this
test.

WARNING

No DC Input Voltage to Power Supply Module

Table 6-22: No DC Input Voltage to Power Supply Module

Step Action

1 Verify DC power is applied to the BTS frame.

2 Verify there are no breakers tripped.

* IMPORTANT
If a breaker has tripped, remove all modules from the applicable shelf supplied by the breaker and
attempt to reset it.

– If the breaker trips again, there is probably a cable or breaker problem within the frame.

– If the breaker does not trip, there is probably a defective module or sub–assembly within the shelf.

3 Verify that the C–CCP shelf breaker on the BTS frame breaker panel is functional.

4 Use a voltmeter to determine if the input voltage is being routed to the C–CCP backplane by
measuring the DC voltage level on the PWR_IN cable.

– If the voltage is not present, there is probably a cable or breaker problem within the frame.

– If the voltage is present at the connector, reconnect and measure the level at the “VCC” power
feed clip on the distribution backplane.

– If the voltage is correct at the power clip, inspect the clip for damage.

5 If everything appears to be correct, visually inspect the power supply module connectors.

6 Replace the power supply module with a known good module.

7 If steps 1 through 5 fail to indicate a problem, a C–CCP backplane failure (possibly an open trace) has
occurred.
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No DC Voltage (+5, +6.5, or +15 Volts) to a Specific GLI2,
BBX, or Switchboard

Perform the procedure in Table 6-23 to troubleshoot a DC input voltage
to GLI2, BBX, or Switchboard failure.

Table 6-23: No DC Input Voltage to any C–CCP Shelf Module

Step Action

1 Verify the steps in Table 6-22 have been performed.

2 Inspect the defective board/module (both board and backplane) connector for damage.

3 Replace suspect board/module with known good board/module.

TX and RX Signal Routing
Problems

Perform the procedure in Table 6-24 to troubleshoot TX and RX signal
routing problems.

Table 6-24: TX and RX Signal Routing Problems

Step Action

1 Inspect all Harting Cable connectors and back–plane connectors for damage in all the affected board
slots.

2 Perform steps in the RF path troubleshooting flowchart in this manual.
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Module Status Indicators

Each of the non-passive plug-in modules has a bi-color (green & red)
LED status indicator located on the module front panel. The indicator is
labeled PWR/ALM. If both colors are turned on, the indicator is yellow.

Each plug-in module, except for the fan module, has its own alarm
(fault) detection circuitry that controls the state of the PWR/ALM LED.

The fan TACH signal of each fan module is monitored by the AMR.
Based on the status of this signal, the AMR controls the state of the
PWR/ALM LED on the fan module.

LED Status Combinations for
All Modules (except GLI2,
CSM, BBX, MCC)

PWR/ALM LED

The following list describes the states of the module status indicator.

� Solid GREEN –  module operating in a normal (fault free) condition.

� Solid RED – module is operating in a fault (alarm) condition due to
electrical hardware failure.

Note that a fault (alarm) indication may or may not be due to a complete
module failure and normal service may or may not be reduced or
interrupted.

DC/DC Converter LED Status
Combinations

The PWR CNVTR has alarm (fault) detection circuitry that controls the
state of the PWR/ALM LED. This is true for both the C–CCP and LPA
power converters.

PWR/ALM LED

The following list describes the states of the bi-color LED.

� Solid GREEN –  module operating in a normal (fault free) condition.

� Solid RED –  module is operating in a fault (alarm) condition due to
electrical hardware problem.
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CSM LED Status
Combinations

PWR/ALM LED

The CSMs include on-board alarm detection. Hardware and
software/firmware alarms are indicated via the front panel indicators.

After the memory tests, the CSM loads OOS–RAM code from the Flash
EPROM, if available. If not available, the OOS–ROM code is loaded
from the Flash EPROM.

� Solid GREEN – module is INS_ACT or INS_STBY no alarm.

� Solid RED – Initial power up or module is operating in a fault (alarm)
condition.

� Slowly Flashing GREEN – OOS_ROM no alarm.

� Long RED/Short GREEN – OOS_ROM alarm.

� Rapidly Flashing GREEN – OOS_RAM no alarm or INS_ACT in
DUMB mode.

� Short RED/Short GREEN – OOS_RAM alarm.

� Long GREEN/Short RED – INS_ACT  or INS_STBY alarm.

� Off – no DC power  or on-board fuse is open.

� Solid YELLOW – After a reset, the CSMs begin to boot. During
SRAM test and Flash EPROM code check, the LED is yellow. (If
SRAM or Flash EPROM fail, the LED changes to a solid RED and
the CSM attempts to reboot.)

PWR/ALM
Indicator

FREQ
MONITOR

SYNC
MONITOR

FW00303

Figure 6-1: CSM Front Panel Indicators & Monitor Ports

 . . . continued on next page
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FREQ Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the 19.6608 MHz clock generated by the CSM. When
both CSM 1 and CSM 2 are in an in-service (INS) condition, the CSM 2
clock signal frequency is the same as that output by CSM 1.

The clock is a sine wave signal with a minimum amplitude of +2 dBm
(800 mVpp) into a 50 Ω load connected to this port.

SYNC Monitor Connector

A test port provided at the CSM front panel via a BNC receptacle allows
monitoring of the “Even Second Tick” reference signal generated by the
CSMs.

At this port, the reference signal is a TTL active high signal with a pulse
width of 153 nanoseconds.

MMI Connector – Only accessible behind front panel. The RS–232
MMI port connector is intended to be used primarily in the development
or factory environment, but may be used in the field for
debug/maintenance purposes.
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GLI2 LED Status
Combinations

The GLI2 module has indicators, controls and connectors as described
below and shown in Figure 6-2.

The operating states of the 5 LEDs are:

ACTIVE
Solid GREEN – GLI2 is active. This means that the GLI2 has shelf
control and is providing control of the digital interfaces.

Off – GLI2 is not active (i.e., Standby). The mate GLI2 should be
active.

MASTER

� Solid GREEN – GLI2 is Master (sometimes referred to as MGLI2).

� Off – GLI2 is non-master (i.e., Slave).

ALARM

� Solid RED – GLI2 is in a fault condition or in reset.

� While in reset transition,  STATUS LED is OFF while GLI2 is
performing ROM boot (about 12 seconds for normal boot).

� While in reset transition,  STATUS LED is ON while GLI2 is
performing RAM boot (about 4 seconds for normal boot).

� Off – No Alarm.

STATUS

� Flashing GREEN– GLI2 is in service (INS), in a stable operating
condition.

� On – GLI2 is in OOS RAM state operating downloaded code.

� Off – GLI2 is in OOS ROM state operating boot code.

SPANS

� Solid GREEN – Span line is connected and operating.

� Solid RED – Span line is disconnected or a fault condition exists.
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GLI2 Pushbuttons and
Connectors

RESET Pushbutton – Depressing the RESET pushbutton causes a
partial reset of the CPU and a reset of all board devices. The GLI2 is
placed in the OOS_ROM state

MMI Connector – The RS–232MMI port connector is intended to be
used primarily in the development or factory environment but may be
used in the field for debug/maintenance purposes.

LAN Connectors (A & B) – The two 10BASE2 Ethernet circuit board
mounted BNC connectors are located on the bottom front edge of the
GLI2; one for each LAN interface, A & B. Ethernet cabling is connected
to tee connectors fastened to these BNC connectors.

Figure 6-2: GLI2 Front Panel
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BBX LED Status
Combinations

PWR/ALM LED

The BBX module has its own alarm (fault) detection circuitry that
controls the state of the PWR/ALM LED.

The following list describes the states of the bi-color LED:

� Solid GREEN – INS_ACT no alarm

� Solid RED Red – initializing or power-up alarm

� Slowly Flashing GREEN – OOS_ROM no alarm

� Long RED/Short GREEN – OOS_ROM alarm

� Rapidly Flashing GREEN – OOS_RAM no alarm

� Short RED/Short GREEN – OOS_RAM alarm

� Long GREEN/Short RED – INS_ACT  alarm

MCC LED Status
Combinations

The MCC module has LED indicators and connectors as described
below (see Figure 6-3). Note that the figure does not show the
connectors as they are concealed by the removable lens.

The LED indicators and their states are as follows:

PWR/ALM LED

� RED – fault on module

ACTIVE LED

� Off – module is inactive, off-line, or not processing traffic.

� Slowly Flashing GREEN – OOS_ROM no alarm.

� Rapidly Flashing Green – OOS_RAM no alarm.

� Solid GREEN – module is INS_ACT, on-line, processing traffic.

PWR/ALM and ACTIVE LEDs

� Solid RED – module is powered but is in reset or the BCP is inactive.

MMI Connectors

� The RS–232 MMI port connector (four-pin) is intended to be used
primarily in the development or factory environment but may be used
in the field for debugging purposes.

� The RJ–11 ethernet port connector (eight-pin) is intended to be used
primarily in the development environment but may be used in the field
for high data rate debugging purposes.

 . . . continued on next page
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Figure 6-3: MCC Front Panel
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LPA Shelf LED Status
Combinations

LPA Module LED

Each LPA module contains a bi–color LED just above the MMI
connector on the front panel of the module. Interpret this LED as
follows:

� GREEN — LPA module is active and is reporting no alarms (Normal
condition).

� Flashing GREEN/RED — LPA module is active but is reporting an
low input power condition. If no BBX is keyed, this is normal and
does not constitute a failure.
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Span Problems (No Control
Link)

Perform the procedure in Table 6-25 to troubleshoot a control link
failure.

Table 6-25: Troubleshooting Control Link Failure

� Step Action

1 Verify the span settings using the span_view  command on the active master GLI2 MMI port. If
these are correct, verify the edlc parameters using the show command. Any alarms conditions
indicate that the span is not operating correctly.

– Try looping back the span line from the DSX panel back to the Mobility Manager (MM) and
verify that the looped signal is good.

– Listen for control tone on appropriate timeslot from Base Site and MM.

2 If no traffic channels in groomed MCCs (or in whole C–CCP shelf) can process calls, verify that
the ISB cabling is correct and that ISB A and ISB B cables are not swapped.
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Notes
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Verification of Test Equipment
Used

Table A-1: Verification of Test Equipment Used

Manufacturer Model Serial Number

Comments:________________________________________________________

__________________________________________________________________
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Site Checklist

Table A-2: Site Checklist

OK Parameter Specification Comments

� Deliveries Per established procedures

� Floor Plan Verified

�

�

�

Inter Frame Cables:

Ethernet

Frame Ground

Power

Per procedure

Per procedure

Per procedure

�

�

�

Factory Data:

BBX

Test Panel

RFDS

Per procedure

Per procedure

Per procedure

� Site Temperature

� Dress Covers/Brackets

Preliminary Operations

Table A-3: Preliminary Operations

OK Parameter Specification Comments

� Shelf ID Dip Switches Per site equipage

� BBX Jumpers Verified per procedure

� Ethernet LAN verification Verified per procedure

Comments:_________________________________________________________

A



Optimization (Pre–ATP) Data Sheets – continued

Mar 2001 A-3SC�4812T CDMA BTS Optimization/ATP
DRAFT

Pre–Power and Initial Power
Tests

Table A-4: Pre–power Checklist

OK Parameter Specification Comments

� Pre–power–up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications

�

�

�

�

�

�

�

�

Internal Cables:

ISB (all cages)

CSM (all cages)

Power (all cages)

Ethernet Connectors

LAN A ohms

LAN B ohms

LAN A shield

LAN B shield

Ethernet Boots

verified

verified

verified

verified

verified

isolated

isolated

installed

� Air Impedance Cage (single cage) installed

� Initial power–up tests Verify power supply
output voltage at the top
of each BTS frame is
within specifications:

Comments:_________________________________________________________

A



Optimization (Pre–ATP) Data Sheets – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001A-4

General Optimization
Checklist

Table A-5: Pre–power Checklist

OK Parameter Specification Comments

�

�

LEDs

Frame fans

illuminated

operational

�

�

�

�

�

�

LMF to BTS Connection

Preparing the LMF

Log into the LMF PC

Create site specific BTS directory

Create master–bts–cdma directory

Download device loads

Moving/Linking files

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

�

�

Ping LAN A

Ping LAN B

per procedure

per procedure

�

�

�

�

�

�

�

�

�

�

Download/Enable MGLI2s

Download/Enable GLI2s

Set Site Span Configuration

Download CSMs

Download

Enable CSMs

Download/Enable MCCs

Download BBXs

Download TSU (in RFDS)

Program TSU NAM

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

per procedure

� Test Set Calibration per procedure

Comments:_________________________________________________________
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GPS Receiver Operation

Table A-6: GPS Receiver Operation

OK Parameter Specification Comments

� GPS Receiver Control Task State:

tracking satellites

Verify parameter

� Initial Position Accuracy: Verify Estimated
or Surveyed

� Current Position:
lat
lon
height

RECORD in ms
and cm also
convert to deg
min sec

� Current Position: satellites tracked

Estimated:

(>4) satellites tracked,(>4) satellites visible

Surveyed:

(>1) satellite tracked,(>4) satellites visible

Verify parameter
as appropriate:

� GPS Receiver Status:Current Dilution of
Precision 
(PDOP or HDOP): (<30)

Verify parameter

� Current reference source:
Number: 0; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LFR Receiver Operation

Table A-7: LFR Receiver Operation

OK Parameter Specification Comments

� Station call letters M X Y Z
assignment.

as specified in site
documentation

� SN ratio is > 8 dB

� LFR Task State: 1fr

locked to station xxxx

Verify parameter

� Current reference source:

Number: 1; Status: Good; Valid: Yes

Verify parameter

Comments:_________________________________________________________
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LPA IM Reduction

Table A-8: LPA IM Reduction

Parameter Comments

CARRIER
OK LPA

# 4:1 & 2:1
3–Sector

2:1
6–Sector

Dual BP
3–Sector

Dual BP
6–Sector

Specification

� 1A C1 C1 C1 C1 No Alarms

� 1B C1 C1 C1 C1 No Alarms

� 1C C1 C1 C1 C1 No Alarms

� 1D C1 C1 C1 C1 No Alarms

� 2A C2 C2 C2 No Alarms

� 2B C2 C2 C2 No Alarms

� 2C C2 C2 C2 No Alarms

� 2D C2 C2 C2 No Alarms

� 3A C3 C1 C1 No Alarms

� 3B C3 C1 C1 No Alarms

� 3C C3 C1 C1 No Alarms

� 3D C3 C1 C1 No Alarms

� 4A C4 C2 No Alarms

� 4B C4 C2 No Alarms

� 4C C4 C2 No Alarms

� 4D C4 C2 No Alarms

Comments:_________________________________________________________

Cx – denotes physical carriers

For applied frequency requirements, see Appendix E.
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LPA Convergence

Table A-9: LPA Convergence

OK Parameter Specification Data

LPA # Converged

� 1A Verify per procedure & upload

� 1B
convergence data

� 1C

� 1D

� 2A Verify per procedure & upload

� 2B
convergence data

� 2C

� 2D

� 3A Verify per procedure & upload

� 3B
convergence data

� 3C

� 3D

� 4A Verify per procedure & upload

� 4B
convergence data

� 4C

� 4D

A
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TX Bay Level Offset/Power
Output Verification for
3–Sector Configurations

1–Carrier
2–Carrier Non–adjacent Channels
4–Carrier Non–adjacent Channels

Table A-10: TX BLO Calibration (3–Sector: 1–Carrier,  2–Carrier and 4–Carrier Non–adjacent Channels)

OK Parameter Specification Comments

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

�
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

�
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–4, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–5, ANT–2 = dB

BBX–r, ANT–2 = dB

�
BBX–6, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–10, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–11, ANT–2 = dB

BBX–r, ANT–2 = dB

�
BBX–12, ANT–3 = dB

BBX–r, ANT–3 = dB

. . . continued on next page
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Table A-10: TX BLO Calibration (3–Sector: 1–Carrier,  2–Carrier and 4–Carrier Non–adjacent Channels)

OK CommentsSpecificationParameter

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

�

carrier 1
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

�

carrier 2
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–4, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–5, ANT–2 = dB

BBX–r, ANT–2 = dB

�

carrier 3
BBX–6, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–10, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–11, ANT–2 = dB

BBX–r, ANT–2 = dB

�

carrier 4
BBX–12, ANT–3 = dB

BBX–r, ANT–3 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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2–Carrier Adjacent Channel

Table A-11: TX Bay Level Offset Calibration (3–Sector: 2–Carrier Adjacent Channels)

OK Parameter Specification Comments

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

�
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–7, ANT–4 = dB

BBX–r, ANT–4 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (typical),
38 dB (minimum) prior to calibration

BBX–8, ANT–5 = dB

BBX–r, ANT–5 = dB

�
BBX–9, ANT–6 = dB

BBX–r, ANT–6 = dB

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

�

carrier 1
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–7, ANT–4 = dB

BBX–r, ANT–4 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–8, ANT–5 = dB

BBX–r, ANT–5 = dB

�

carrier 2
BBX–9, ANT–6 = dB

BBX–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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3–Carrier Adjacent Channels
4–Carrier Adjacent Channels

Table A-12: TX Bay Level Offset Calibration (3–Sector: 3 or 4–Carrier Adjacent Channels)

OK Parameter Specification Comments

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibrate
carrier 1

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

�
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibrate
carrier 2

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

�
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

�
Calibrate
carrier 3

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

�
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

�
BBX–10, ANT–4 = dB

BBX–3, ANT–4 = dB

�
Calibrate
carrier 4

TX Bay Level Offset = 42 dB (+4 dB)
prior to calibration

BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

�
BBX–12, ANT–6 = dB

BBX–r, ANT–6 = dB

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibration

Audit
carrier 1

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

�

carrier 1
BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

. . . continued on next page
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Table A-12: TX Bay Level Offset Calibration (3–Sector: 3 or 4–Carrier Adjacent Channels)

OK CommentsSpecificationParameter

�
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

�
Calibration

Audit
carrier 2

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

�

carrier 2
BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

�
BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

�
Calibration

Audit
carrier 3

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

�

carrier 3
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

�
BBX–10, ANT–4 = dB

BBX–r, ANT–4 = dB

�
Calibration

Audit
carrier 4

0 dB (+0.5 dB) for gain set resolution
post calibration

BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

�

carrier 4
BBX–12, ANT–6 = dB

BBX–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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TX Bay Level Offset/Power
Output Verification for
6–Sector Configurations

1–Carrier
2–Carrier Non–adjacent Channels

Table A-13: TX BLO Calibration (6–Sector: 1–Carrier, 2–Carrier Non–adjacent Channels)

OK Parameter Specification Comments

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

�

carrier 1 38 dB (minimum) prior to calibration BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

�
BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

�
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

�
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

�
BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

�
Calibrate TX Bay Level Offset = 42 dB (typical),

BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

�

carrier 2 38 dB (minimum) prior to calibration BBX–10, ANT–4 = dB

BBX–3, ANT–4 = dB

�
BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

�
BBX–12, ANT–6 = dB

BBX–r, ANT–5 = dB

. . . continued on next page
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Table A-13: TX BLO Calibration (6–Sector: 1–Carrier, 2–Carrier Non–adjacent Channels)

OK CommentsSpecificationParameter

�
BBX–1, ANT–1 = dB

BBX–r, ANT–1 = dB

�
BBX–2, ANT–2 = dB

BBX–r, ANT–2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX–3, ANT–3 = dB

BBX–r, ANT–3 = dB

�

Audit
carrier 1

post calibration BBX–4, ANT–4 = dB

BBX–r, ANT–4 = dB

�
BBX–5, ANT–5 = dB

BBX–r, ANT–5 = dB

�
BBX–6, ANT–6 = dB

BBX–r, ANT–6 = dB

�
BBX–7, ANT–1 = dB

BBX–r, ANT–1 = dB

�
BBX–8, ANT–2 = dB

BBX–r, ANT–2 = dB

� Calibration 0 dB (+0.5 dB) for gain set resolution

BBX–9, ANT–3 = dB

BBX–r, ANT–3 = dB

�

Audit
carrier 2

post calibration BBX–10, ANT–4 = dB

BBX–r, ANT–4 = dB

�
BBX–11, ANT–5 = dB

BBX–r, ANT–5 = dB

�
BBX–12, ANT–6 = dB

BBX–r, ANT–6 = dB

 

Comments:________________________________________________________

__________________________________________________________________
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BTS Redundancy/Alarm Tests

Table A-14: BTS Redundancy/Alarm Tests

OK Parameter Specification Data

� SIF: Misc. alarm tests Verify per procedure

� MGLI2 redundancy test Verify per procedure

� GLI2 redundancy test Verify per procedure

�
Power supply/converter
redundancy

Verify per procedure

� Misc. alarm tests Verify per procedure

�
CSM, GPS, & LFR
redundancy/alarm tests

Verify per procedure

� LPA redundancy test Verify per procedure

Comments:________________________________________________________

__________________________________________________________________

TX Antenna VSWR

Table A-15: TX Antenna VSWR

OK Parameter Specification Data

�
VSWR – 
Antenna 1

   < (1.5 : 1)

�
VSWR –
Antenna 2

   < (1.5 : 1)

�
VSWR –
Antenna 3

   < (1.5 : 1)

�
VSWR –
Antenna 4

   < (1.5 : 1)

�
VSWR –
Antenna 5

   < (1.5 : 1)

�
VSWR –
Antenna 6

   < (1.5 : 1)

Comments:________________________________________________________

__________________________________________________________________
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RX Antenna VSWR

Table A-16: RX Antenna VSWR

OK Parameter Specification Data

�
VSWR – 
Antenna 1

   < (1.5 : 1)

�
VSWR –
Antenna 2

   < (1.5 : 1)

�
VSWR –
Antenna 3

   < (1.5 : 1)

�
VSWR –
Antenna 4

   < (1.5 : 1)

�
VSWR –
Antenna 5

   < (1.5 : 1)

�
VSWR –
Antenna 6

   < (1.5 : 1)

Comments:_________________________________________________________

AMR Verification

Table A-17: AMR CDI Alarm Input Verification

OK Parameter Specification Data

�

Verify CDI alarm input
operation (“ALARM A”
(numbers 1 –18)

BTS Relay #XX –
Contact Alarm
Sets/Clears

�

Verify CDI alarm input
operation (“ALARM B” 
(numbers 19 –36)

BTS Relay #XX –
Contact Alarm
Sets/Clears

Comments:_________________________________________________________
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Date Site

C–CCP Shelf

Site I/O A & B
C–CCP Shelf
CSM–1

CSM–2

HSO

CCD–1

CCD–2

AMR–1

AMR–2

MPC–1
MPC–2

Fans 1–3 

GLI2–1

GLI2–2

BBX–1

BBX–2

BBX–3

BBX–4

BBX–5

BBX–6

BBX–7

BBX–8

BBX–9

BBX–10
BBX–11

BBX–12

BBX–r

MCC–1

MCC–2

MCC–3

MCC–4

MCC–5

MCC–6

MCC–7

MCC–8

MCC–9

 . . . continued on next page
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MCC–1–10

MCC–11

MCC–1–12

CIO
SWITCH

PS–1

PS–2

PS–3

LPAs

LPA 1A

LPA 1B

LPA 1C

LPA 1D

LPA 2A

LPA 2B

LPA 2C

LPA 2D

LPA 3A

LPA 3B

LPA 3C

LPA 3D

LPA 4A

LPA 4B

LPA 4C

LPA 4D

Power Conversion Shelf
(–48 V BTS Only)

AMR

PS 4

PS 5

PS 6

PS 7

PS 8

PS 9

A
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Notes
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PN Offset Background

All channel elements transmitted from a BTS in a particular 1.25 MHz
CDMA channel are orthonogonally spread by 1 of 64 possible Walsh
code functions; additionally, they are also spread by a quadrature pair of
PN sequences unique to each sector.

Overall, the mobile uses this to differentiate multiple signals transmitted
from the same BTS (and surrounding BTS) sectors, and to synchronize
to the next strongest sector.

The PN offset per sector is stored on the BBXs, where the corresponding
I & Q registers reside.

The PN offset values are determined on a per BTS/per sector(antenna)
basis as determined by the appropriate cdf file content. A breakdown of
this information is found in Table B-1.

PN Offset Usage

Only the 14–chip delay is currently in use. It is important to determine
the RF chip delay to be able to test the BTS functionality. This can be
done by ascertaining if the CDF file FineTxAdj  value was set to “on”
when the MCC was downloaded with “image data”. The FineTxAdj
value is used to compensate for the processing delay (approximately
20 �S) in the BTS using any type of mobile meeting IS–97
specifications.

If the FineTxAdj value in the cdf file is 213 (D5 HEX), FineTxAdj has
been set for the 14 chip table.

CDF file I and Q values can be represented in DECIMAL
or HEX. If using HEX, add 0x before the HEX value. If
necessary, convert HEX values in Table B-1 to decimal
before comparing them to cdf file I & Q value assignments.

IMPORTANT

*
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PN Offset Programming Information – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001B-2

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

0 17523 23459 4473 5BA3

1 32292 32589 7E24 7F4D
2 4700 17398 125C 43F6

3 14406 26333 3846 66DD
4 14899 4011 3A33 0FAB

5 17025 2256 4281 08D0
6 14745 18651 3999 48DB

7 2783 1094 0ADF 0446
8 5832 21202 16C8 52D2

9 12407 13841 3077 3611
10 31295 31767 7A3F 7C17

11 7581 18890 1D9D 49CA
12 18523 30999 485B 7917

13 29920 22420 74E0 5794
14 25184 20168 6260 4EC8

15 26282 12354 66AA 3042
16 30623 11187 779F 2BB3

17 15540 11834 3CB4 2E3A
18 23026 10395 59F2 289B

19 20019 28035 4E33 6D83
20 4050 27399 0FD2 6B07

21 1557 22087 0615 5647
22 30262 2077 7636 081D

23 18000 13758 4650 35BE
24 20056 11778 4E58 2E02

25 12143 3543 2F6F 0DD7
26 17437 7184 441D 1C10

27 17438 2362 441E 093A
28 5102 25840 13EE 64F0

29 9302 12177 2456 2F91
30 17154 10402 4302 28A2

31 5198 1917 144E 077D
32 4606 17708 11FE 452C

33 24804 10630 60E4 2986
34 17180 6812 431C 1A9C

35 10507 14350 290B 380E
36 10157 10999 27AD 2AF7

37 23850 25003 5D2A 61AB
38 31425 2652 7AC1 0A5C

39 4075 19898 0FEB 4DBA
40 10030 2010 272E 07DA

41 16984 25936 4258 6550
42 14225 28531 3791 6F73

43 26519 11952 6797 2EB0
44 27775 31947 6C7F 7CCB

45 30100 25589 7594 63F5
46 7922 11345 1EF2 2C51

47 14199 28198 3777 6E26
48 17637 13947 44E5 367B

49 23081 8462 5A29 210E
50 5099 9595 13EB 257B

. . . continued on next page
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PN Offset Programming Information – continued

Mar 2001 B-3SC�4812T CDMA BTS Optimization/ATP
DRAFT

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

51 32743 4670 7FE7 123E

52 7114 14672 1BCA 3950
53 7699 29415 1E13 72E7

54 19339 20610 4B8B 5082
55 28212 6479 6E34 194F

56 29587 10957 7393 2ACD
57 19715 18426 4D03 47FA

58 14901 22726 3A35 58C6
59 20160 5247 4EC0 147F

60 22249 29953 56E9 7501
61 26582 5796 67D6 16A4

62 7153 16829 1BF1 41BD
63 15127 4528 3B17 11B0

64 15274 5415 3BAA 1527
65 23149 10294 5A6D 2836

66 16340 17046 3FD4 4296
67 27052 7846 69AC 1EA6

68 13519 10762 34CF 2A0A
69 10620 13814 297C 35F6

70 15978 16854 3E6A 41D6
71 27966 795 6D3E 031B

72 12479 9774 30BF 262E
73 1536 24291 0600 5EE3

74 3199 3172 0C7F 0C64
75 4549 2229 11C5 08B5

76 17888 21283 45E0 5323
77 13117 16905 333D 4209

78 7506 7062 1D52 1B96
79 27626 7532 6BEA 1D6C

80 31109 25575 7985 63E7
81 29755 14244 743B 37A4

82 26711 28053 6857 6D95
83 20397 30408 4FAD 76C8

84 18608 5094 48B0 13E6
85 7391 16222 1CDF 3F5E

86 23168 7159 5A80 1BF7
87 23466 174 5BAA 00AE

88 15932 25530 3E3C 63BA
89 25798 2320 64C6 0910

90 28134 23113 6DE6 5A49
91 28024 23985 6D78 5DB1

92 6335 2604 18BF 0A2C
93 21508 1826 5404 0722

94 26338 30853 66E2 7885
95 17186 15699 4322 3D53

96 22462 2589 57BE 0A1D
97 3908 25000 0F44 61A8

98 25390 18163 632E 46F3
99 27891 12555 6CF3 310B

100 9620 8670 2594 21DE

. . . continued on next page
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PN Offset Programming Information – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001B-4

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

101 6491 1290 195B 050A

102 16876 4407 41EC 1137
103 17034 1163 428A 048B

104 32405 12215 7E95 2FB7
105 27417 7253 6B19 1C55

106 8382 8978 20BE 2312
107 5624 25547 15F8 63CB

108 1424 3130 0590 0C3A
109 13034 31406 32EA 7AAE

110 15682 6222 3D42 184E
111 27101 20340 69DD 4F74

112 8521 25094 2149 6206
113 30232 23380 7618 5B54

114 6429 10926 191D 2AAE
115 27116 22821 69EC 5925

116 4238 31634 108E 7B92
117 5128 4403 1408 1133

118 14846 689 39FE 02B1
119 13024 27045 32E0 69A5

120 10625 27557 2981 6BA5
121 31724 16307 7BEC 3FB3

122 13811 22338 35F3 5742
123 24915 27550 6153 6B9E

124 1213 22096 04BD 5650
125 2290 23136 08F2 5A60

126 31551 12199 7B3F 2FA7
127 12088 1213 2F38 04BD

128 7722 936 1E2A 03A8
129 27312 6272 6AB0 1880

130 23130 32446 5A5A 7EBE
131 594 13555 0252 34F3

132 25804 8789 64CC 2255
133 31013 24821 7925 60F5

134 32585 21068 7F49 524C
135 3077 31891 0C05 7C93

136 17231 5321 434F 14C9
137 31554 551 7B42 0227

138 8764 12115 223C 2F53
139 15375 4902 3C0F 1326

140 13428 1991 3474 07C7
141 17658 14404 44FA 3844

142 13475 17982 34A3 463E
143 22095 19566 564F 4C6E

144 24805 2970 60E5 0B9A
145 4307 23055 10D3 5A0F

146 23292 15158 5AFC 3B36
147 1377 29094 0561 71A6

148 28654 653 6FEE 028D
149 6350 19155 18CE 4AD3

150 16770 23588 4182 5C24

. . . continued on next page
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PN Offset Programming Information – continued

Mar 2001 B-5SC�4812T CDMA BTS Optimization/ATP
DRAFT

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

151 14726 10878 3986 2A7E

152 25685 31060 6455 7954
153 21356 30875 536C 789B

154 12149 11496 2F75 2CE8
155 28966 24545 7126 5FE1

156 22898 9586 5972 2572
157 1713 20984 06B1 51F8

158 30010 30389 753A 76B5
159 2365 7298 093D 1C82

160 27179 18934 6A2B 49F6
161 29740 23137 742C 5A61

162 5665 24597 1621 6015
163 23671 23301 5C77 5B05

164 1680 7764 0690 1E54
165 25861 14518 6505 38B6

166 25712 21634 6470 5482
167 19245 11546 4B2D 2D1A

168 26887 26454 6907 6756
169 30897 15938 78B1 3E42

170 11496 9050 2CE8 235A
171 1278 3103 04FE 0C1F

172 31555 758 7B43 02F6
173 29171 16528 71F3 4090

174 20472 20375 4FF8 4F97
175 5816 10208 16B8 27E0

176 30270 17698 763E 4522
177 22188 8405 56AC 20D5

178 6182 28634 1826 6FDA
179 32333 1951 7E4D 079F

180 14046 20344 36DE 4F78
181 15873 26696 3E01 6848

182 19843 3355 4D83 0D1B
183 29367 11975 72B7 2EC7

184 13352 31942 3428 7CC6
185 22977 9737 59C1 2609

186 31691 9638 7BCB 25A6
187 10637 30643 298D 77B3

188 25454 13230 636E 33AE
189 18610 22185 48B2 56A9

190 6368 2055 18E0 0807
191 7887 8767 1ECF 223F

192 7730 15852 1E32 3DEC
193 23476 16125 5BB4 3EFD

194 889 6074 0379 17BA
195 21141 31245 5295 7A0D

196 20520 15880 5028 3E08
197 21669 20371 54A5 4F93

198 15967 8666 3E5F 21DA
199 21639 816 5487 0330

200 31120 22309 7990 5725

. . . continued on next page
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PN Offset Programming Information – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001B-6

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

201 3698 29563 0E72 737B

202 16322 13078 3FC2 3316
203 17429 10460 4415 28DC

204 21730 17590 54E2 44B6
205 17808 20277 4590 4F35

206 30068 19988 7574 4E14
207 12737 6781 31C1 1A7D

208 28241 32501 6E51 7EF5
209 20371 6024 4F93 1788

210 13829 20520 3605 5028
211 13366 31951 3436 7CCF

212 25732 26063 6484 65CF
213 19864 27203 4D98 6A43

214 5187 6614 1443 19D6
215 23219 10970 5AB3 2ADA

216 28242 5511 6E52 1587
217 6243 17119 1863 42DF

218 445 16064 01BD 3EC0
219 21346 31614 5362 7B7E

220 13256 4660 33C8 1234
221 18472 13881 4828 3639

222 25945 16819 6559 41B3
223 31051 6371 794B 18E3

224 1093 24673 0445 6061
225 5829 6055 16C5 17A7

226 31546 10009 7B3A 2719
227 29833 5957 7489 1745

228 18146 11597 46E2 2D4D
229 24813 22155 60ED 568B

230 47 15050 002F 3ACA
231 3202 16450 0C82 4042

232 21571 27899 5443 6CFB
233 7469 2016 1D2D 07E0

234 25297 17153 62D1 4301
235 8175 15849 1FEF 3DE9

236 28519 30581 6F67 7775
237 4991 3600 137F 0E10

238 7907 4097 1EE3 1001
239 17728 671 4540 029F

240 14415 20774 384F 5126
241 30976 24471 7900 5F97

242 26376 27341 6708 6ACD
243 19063 19388 4A77 4BBC

244 19160 25278 4AD8 62BE
245 3800 9505 0ED8 2521

246 8307 26143 2073 661F
247 12918 13359 3276 342F

248 19642 2154 4CBA 086A
249 24873 13747 6129 35B3

250 22071 27646 5637 6BFE

. . . continued on next page
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PN Offset Programming Information – continued

Mar 2001 B-7SC�4812T CDMA BTS Optimization/ATP
DRAFT

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

251 13904 1056 3650 0420

252 27198 1413 6A3E 0585
253 3685 3311 0E65 0CEF

254 16820 4951 41B4 1357
255 22479 749 57CF 02ED

256 6850 6307 1AC2 18A3
257 15434 961 3C4A 03C1

258 19332 2358 4B84 0936
259 8518 28350 2146 6EBE

260 14698 31198 396A 79DE
261 21476 11467 53E4 2CCB

262 30475 8862 770B 229E
263 23984 6327 5DB0 18B7

264 1912 7443 0778 1D13
265 26735 28574 686F 6F9E

266 15705 25093 3D59 6205
267 3881 6139 0F29 17FB

268 20434 22047 4FD2 561F
269 16779 32545 418B 7F21

270 31413 7112 7AB5 1BC8
271 16860 28535 41DC 6F77

272 8322 10378 2082 288A
273 28530 15065 6F72 3AD9

274 26934 5125 6936 1405
275 18806 12528 4976 30F0

276 20216 23215 4EF8 5AAF
277 9245 20959 241D 51DF

278 8271 3568 204F 0DF0
279 18684 26453 48FC 6755

280 8220 29421 201C 72ED
281 6837 24555 1AB5 5FEB

282 9613 10779 258D 2A1B
283 31632 25260 7B90 62AC

284 27448 16084 6B38 3ED4
285 12417 26028 3081 65AC

286 30901 29852 78B5 749C
287 9366 14978 2496 3A82

288 12225 12182 2FC1 2F96
289 21458 25143 53D2 6237

290 6466 15838 1942 3DDE
291 8999 5336 2327 14D8

292 26718 21885 685E 557D
293 3230 20561 0C9E 5051

294 27961 30097 6D39 7591
295 28465 21877 6F31 5575

296 6791 23589 1A87 5C25
297 17338 26060 43BA 65CC

298 11832 9964 2E38 26EC
299 11407 25959 2C8F 6567

300 15553 3294 3CC1 0CDE

. . . continued on next page
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PN Offset Programming Information – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001B-8

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

301 17418 30173 440A 75DD

302 14952 15515 3A68 3C9B
303 52 5371 0034 14FB

304 27254 10242 6A76 2802
305 15064 28052 3AD8 6D94

306 10942 14714 2ABE 397A
307 377 19550 0179 4C5E

308 14303 8866 37DF 22A2
309 24427 15297 5F6B 3BC1

310 26629 10898 6805 2A92
311 20011 31315 4E2B 7A53

312 16086 19475 3ED6 4C13
313 24374 1278 5F36 04FE

314 9969 11431 26F1 2CA7
315 29364 31392 72B4 7AA0

316 25560 4381 63D8 111D
317 28281 14898 6E79 3A32

318 7327 23959 1C9F 5D97
319 32449 16091 7EC1 3EDB

320 26334 9037 66DE 234D
321 14760 24162 39A8 5E62

322 15128 6383 3B18 18EF
323 29912 27183 74D8 6A2F

324 4244 16872 1094 41E8
325 8499 9072 2133 2370

326 9362 12966 2492 32A6
327 10175 28886 27BF 70D6

328 30957 25118 78ED 621E
329 12755 20424 31D3 4FC8

330 19350 6729 4B96 1A49
331 1153 20983 0481 51F7

332 29304 12372 7278 3054
333 6041 13948 1799 367C

334 21668 27547 54A4 6B9B
335 28048 8152 6D90 1FD8

336 10096 17354 2770 43CA
337 23388 17835 5B5C 45AB

338 15542 14378 3CB6 382A
339 24013 7453 5DCD 1D1D

340 2684 26317 0A7C 66CD
341 19018 5955 4A4A 1743

342 25501 10346 639D 286A
343 4489 13200 1189 3390

344 31011 30402 7923 76C2
345 29448 7311 7308 1C8F

346 25461 3082 6375 0C0A
347 11846 21398 2E46 5396

348 30331 31104 767B 7980
349 10588 24272 295C 5ED0

350 32154 27123 7D9A 69F3

. . . continued on next page

B



PN Offset Programming Information – continued

Mar 2001 B-9SC�4812T CDMA BTS Optimization/ATP
DRAFT

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

351 29572 5578 7384 15CA

352 13173 25731 3375 6483
353 10735 10662 29EF 29A6

354 224 11084 00E0 2B4C
355 12083 31098 2F33 797A

356 22822 16408 5926 4018
357 2934 6362 0B76 18DA

358 27692 2719 6C2C 0A9F
359 10205 14732 27DD 398C

360 7011 22744 1B63 58D8
361 22098 1476 5652 05C4

362 2640 8445 0A50 20FD
363 4408 21118 1138 527E

364 102 22198 0066 56B6
365 27632 22030 6BF0 560E

366 19646 10363 4CBE 287B
367 26967 25802 6957 64CA

368 32008 2496 7D08 09C0
369 7873 31288 1EC1 7A38

370 655 24248 028F 5EB8
371 25274 14327 62BA 37F7

372 16210 23154 3F52 5A72
373 11631 13394 2D6F 3452

374 8535 1806 2157 070E
375 19293 17179 4B5D 431B

376 12110 10856 2F4E 2A68
377 21538 25755 5422 649B

378 10579 15674 2953 3D3A
379 13032 7083 32E8 1BAB

380 14717 29096 397D 71A8
381 11666 3038 2D92 0BDE

382 25809 16277 64D1 3F95
383 5008 25525 1390 63B5

384 32418 20465 7EA2 4FF1
385 22175 28855 569F 70B7

386 11742 32732 2DDE 7FDC
387 22546 20373 5812 4F95

388 21413 9469 53A5 24FD
389 133 26155 0085 662B

390 4915 6957 1333 1B2D
391 8736 12214 2220 2FB6

392 1397 21479 0575 53E7
393 18024 31914 4668 7CAA

394 15532 32311 3CAC 7E37
395 26870 11276 68F6 2C0C

396 5904 20626 1710 5092
397 24341 423 5F15 01A7

398 13041 2679 32F1 0A77
399 23478 15537 5BB6 3CB1

400 1862 10818 0746 2A42

. . . continued on next page
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PN Offset Programming Information – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001B-10

Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

401 5850 23074 16DA 5A22

402 5552 20250 15B0 4F1A
403 12589 14629 312D 3925

404 23008 29175 59E0 71F7
405 27636 13943 6BF4 3677

406 17600 11072 44C0 2B40
407 17000 29492 4268 7334

408 21913 5719 5599 1657
409 30320 7347 7670 1CB3

410 28240 12156 6E50 2F7C
411 7260 25623 1C5C 6417

412 17906 27725 45F2 6C4D
413 5882 28870 16FA 70C6

414 22080 31478 5640 7AF6
415 12183 28530 2F97 6F72

416 23082 24834 5A2A 6102
417 17435 9075 441B 2373

418 18527 32265 485F 7E09
419 31902 3175 7C9E 0C67

420 18783 17434 495F 441A
421 20027 12178 4E3B 2F92

422 7982 25613 1F2E 640D
423 20587 31692 506B 7BCC

424 10004 25384 2714 6328
425 13459 18908 3493 49DC

426 13383 25816 3447 64D8
427 28930 4661 7102 1235

428 4860 31115 12FC 798B
429 13108 7691 3334 1E0B

430 24161 1311 5E61 051F
431 20067 16471 4E63 4057

432 2667 15771 0A6B 3D9B
433 13372 16112 343C 3EF0

434 28743 21062 7047 5246
435 24489 29690 5FA9 73FA

436 249 10141 00F9 279D
437 19960 19014 4DF8 4A46

438 29682 22141 73F2 567D
439 31101 11852 797D 2E4C

440 27148 26404 6A0C 6724
441 26706 30663 6852 77C7

442 5148 32524 141C 7F0C
443 4216 28644 1078 6FE4

444 5762 10228 1682 27F4
445 245 23536 00F5 5BF0

446 21882 18045 557A 467D
447 3763 25441 0EB3 6361

448 206 27066 00CE 69BA
449 28798 13740 707E 35AC

450 32402 13815 7E92 35F7

. . . continued on next page
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PN Offset Programming Information – continued
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Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

451 13463 3684 3497 0E64

452 15417 23715 3C39 5CA3
453 23101 15314 5A3D 3BD2

454 14957 32469 3A6D 7ED5
455 23429 9816 5B85 2658

456 12990 4444 32BE 115C
457 12421 5664 3085 1620

458 28875 7358 70CB 1CBE
459 4009 27264 0FA9 6A80

460 1872 28128 0750 6DE0
461 15203 30168 3B63 75D8

462 30109 29971 759D 7513
463 24001 3409 5DC1 0D51

464 4862 16910 12FE 420E
465 14091 20739 370B 5103

466 6702 10191 1A2E 27CF
467 3067 12819 0BFB 3213

468 28643 19295 6FE3 4B5F
469 21379 10072 5383 2758

470 20276 15191 4F34 3B57
471 25337 27748 62F9 6C64

472 19683 720 4CE3 02D0
473 10147 29799 27A3 7467

474 16791 27640 4197 6BF8
475 17359 263 43CF 0107

476 13248 24734 33C0 609E
477 22740 16615 58D4 40E7

478 13095 20378 3327 4F9A
479 10345 25116 2869 621C

480 30342 19669 7686 4CD5
481 27866 14656 6CDA 3940

482 9559 27151 2557 6A0F
483 8808 28728 2268 7038

484 12744 25092 31C8 6204
485 11618 22601 2D62 5849

486 27162 2471 6A1A 09A7
487 17899 25309 45EB 62DD

488 29745 15358 7431 3BFE
489 31892 17739 7C94 454B

490 23964 12643 5D9C 3163
491 23562 32730 5C0A 7FDA

492 2964 19122 0B94 4AB2
493 18208 16870 4720 41E6

494 15028 10787 3AB4 2A23
495 21901 18400 558D 47E0

496 24566 20295 5FF6 4F47
497 18994 1937 4A32 0791

498 13608 17963 3528 462B
499 27492 7438 6B64 1D0E

500 11706 12938 2DBA 328A

. . . continued on next page
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Table B-1: PnMask I and PnMask Q Values for PilotPn

14–Chip  Delay
 Pilot I Q I Q
  PN (Dec.)          (Hex.)

501 14301 19272 37DD 4B48

502 23380 29989 5B54 7525
503 11338 8526 2C4A 214E

504 2995 18139 0BB3 46DB
505 23390 3247 5B5E 0CAF

506 14473 28919 3889 70F7
507 6530 7292 1982 1C7C

508 20452 20740 4FE4 5104
509 12226 27994 2FC2 6D5A

510 1058 2224 0422 08B0
511 12026 6827 2EFA 1AAB
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FRU Optimization/ATP Test Matrix

Mar 2001 C-1SC�4812T CDMA BTS Optimization/ATP
DRAFT

Usage & Background

Periodic maintenance of a site may also may mandate re–optimization of
specific portions of the site. An outline of some basic guidelines is
included in the following tables.

Re–optimization steps listed for any assembly detailed in
the tables below must be performed anytime an RF cable
associated with it is replaced.

IMPORTANT

*

BTS Frame

Table C-1: When RF Optimization Is required on the BTS

Item Replaced Optimize:

C–CCP Shelf All sector TX and RX paths to all
Combined CDMA Channel Processor
(C–CCP) shelves.

Multicoupler/
Preselector Card

The three or six affected sector RX paths for
the C–CCP shelf in the BTS frames.

Preselector I/O All sector RX paths.

BBX board RX and TX paths of the affected C–CCP
shelf / BBX board.

CIO Card All RX and TX paths of the affected
CDMA carrier.

Any LPA Module The affected sector TX path.

LPA Backplane The affected sector TX path.

LPA Filter The affected sector TX path.

Ancillary Frame 

Item Replaced Optimize:

Directional Coupler All affected sector RX and TX paths to all
BTS frame shelves.

Site filter All affected RX sector paths in all shelves
in all BTS frames.

Any RFDS component
or TSU.

The RFDS calibration RX & TX paths
(MONFWD/GENFWD).

 . . . continued on next page
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DRAFT
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Inter-frame Cabling

Optimization must be performed after the replacement of any RF cabling
between BTS frames.

Table C-2: When to Optimize Inter–frame Cabling

Item Replaced Optimize:

Ancillary frame to BTS
frame (RX) cables

The affected sector/antenna RX
paths.

BTS frame to ancillary frame
(TX) cables

The affected sector/antenna TX paths.

Detailed Optimization/ATP
Test Matrix

Table C-3 outlines in more detail the tests that would need to be
performed if one of the BTS components were to fail and be replaced. It
is also assumed that all modules are placed OOS–ROM via the LMF
until full redundancy of all applicable modules is implemented.

The following guidelines should also be noted when using this table.

Not every procedure required to bring the site back on line
is indicated in Table C-3. It is meant to be used as a
guideline ONLY. The table assumes that the user is familiar
enough with the BTS Optimization/ATP procedure to
understand which test equipment set ups, calibrations, and
BTS site preparation will be required before performing the
Table # procedures referenced.

IMPORTANT

*

Various passive BTS components (such as the TX and RX directional
couplers, Preselector IO, CIO; etc.) only call for a TX or RX calibration
audit to be performed in lieu of a full path calibration. If the RX or TX
path calibration audit fails, the entire RF path calibration will need to be
repeated. If the RF path calibration fails, further troubleshooting is
warranted.

Whenever any C–CCP BACKPLANE is replaced, it is assumed that
only power to the C–CCP shelf being replaced is turned off via the
breaker supplying that shelf.

Whenever any DISTRIBUTION BACKPLANE is replaced it is assumed
that the power to the entire RFM frame is removed and the Preselector
I/O is replaced. The modem frame should be brought up as if it were a
new installation.

 . . . continued on next page
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If any significant change in signal level results from any
component being replaced in the RX or TX signal flow
paths, it would be identified by re–running the RX and TX
calibration audit command.

NOTE

When the CIO is replaced, the C–CCP shelf remains powered up. The
BBX boards may need to be removed, then re–installed into their
original slots, and re–downloaded (code and BLO data). RX and TX
calibration audits should then be performed.

 . . . continued on next page
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Table C-3: SC 4812T BTS Optimization and ATP Test Matrix
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Table 2-1 2-2

Initial Boards/Modules
Install, Preliminary
Operations, CDF Site
Equipage; etc.

� � � � � � � � � � � � � � � � � � � � �

Table 2-2
Table 2-5

2-5
2-13

DC Power Pre-Test
Physical Inspect

� �

Table 2-7 2-14 Initial Power-up � �

Table 3-6 3-15 Ping the Processors � � � � � �

Table 3-12 3-28 Download/Enable
MGLI2s

� �

Table 3-12 3-28 Download/Enable GLIs � �

Table 3-13 3-29 Download CSMs � � �

Table 3-13 3-29 Download MCCs, � � �

Table 3-13 3-29 Download BBXs � �

Table 3-15 3-31 Enable CSMs � �

Table 3-16 3-32 Enable MCCs � �

Table 3-19 3-37 GPS Initialization /
Verification

� � �

Table 3-20 3-41 LFR  Initialization /
Verification

� �

Table 3-21 3-43 HSO
Initialization/Verification � �

Table 3-34 3-70 TX Path Calibration � � �

Table 3-35 3-71 Download Offsets to BBX � � �

Table 3-36 3-73 TX Path Calibration Audit � � � � � � � � � � �

Table 4-1 4-3 Spectral Purity TX Mask
ATP

� � � � � � � �

Table 4-1 4-3 Waveform Quality (rho)
ATP

� � � � � � � � � �

Table 4-1 4-3 Pilot Time Offset ATP � � � � � � � � � �

Table 4-1 4-3 Code Domain Power /
Noise Floor

� � �

Table 4-1 4-3 FER Test � � � � �

NOTE
Replace power converters one card at a time so that power to the C–CCP or LPA shelf is not lost. If power to
the C–CCP shelf is lost, all cards in the shelf must be downloaded again.
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Appendix D: BBX Gain Set Point vs. BTS Output Considerations
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Usage & Background

Table D-1 outlines the relationship between the total of all code domain
channel element gain settings (digital root sum of the squares) and the
BBX Gain Set Point between 33.0 dBm and 44.0 dBm. The resultant RF
output (as measured at the top of the BTS in dBm) is shown in the table.
The table assumes that the BBX Bay Level Offset (BLO) values have
been calculated.

As an illustration, consider a BBX keyed up to produce a CDMA carrier
with only the Pilot channel (no MCCs forward link enabled). Pilot gain
is set to 262. In this case, the BBX Gain Set Point is shown to correlate
exactly to the actual RF output anywhere in the 33 to 44 dBm output
range.  (This is the level used to calibrate the BTS).

Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm�

Gain�
44 43 42 41 40 39 38 37 36 35 34 33

541 – – – – – – – 43.3 42.3 41.3 40.3 39.3

533 – – – – – – – 43.2 42.2 41.2 40.2 39.2

525 – – – – – – 44 43 42 41 40 39

517 – – – – – – 43.9 42.9 41.9 40.9 39.9 38.9

509 – – – – – – 43.8 42.8 41.8 40.8 39.8 38.8

501 – – – – – – 43.6 42.6 41.6 40.6 39.6 38.6

493 – – – – – – 43.5 42.5 41.5 40.5 39.5 38.5

485 – – – – – – 43.4 42.4 41.4 40.4 39.4 38.4

477 – – – – – – 43.2 42.2 41.2 40.2 39.2 38.2

469 – – – – – – 43.1 42.1 41.1 40.1 39.1 38.1

461 – – – – – 43.9 42.9 41.9 40.9 39.9 38.9 37.9

453 – – – – – 43.8 42.8 41.8 40.8 39.8 38.8 37.8

445 – – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6

437 – – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4

429 – – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3

421 – – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1

413 – – – – 44 43 42 41 40 39 38 37

405 – – – – 43.8 42.8 41.8 40.8 39.8 38.8 37.8 36.8

397 – – – – 43.6 42.6 41.6 40.6 39.6 38.6 37.6 36.6

389 – – – – 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4

 . . . continued on next page
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Table D-1: BBX Gain Set Point vs. Actual BTS Output (in dBm)

dBm�

Gain�
333435363738394041424344

381 – – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3

374 – – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1

366 – – – 43.9 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9

358 – – – 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7

350 – – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5

342 – – – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3

334 – – – 43.1 42.1 41.1 40.1 39.1 38.1 37.1 36.1 35.1

326 – – 43.9 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9

318 – – 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7

310 – – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5

302 – – 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2

294 – 44 43 42 41 40 39 38 37 36 35 34

286 – 43.8 42.8 41.8 40.8 39.8 38.8 37.8 36.8 35.8 34.8 33.8

278 – 43.5 42.5 41.5 40.5 39.5 38.5 37.5 36.5 35.5 34.5 33.5

270 – 43.3 42.3 41.3 40.3 39.3 38.3 37.3 36.3 35.3 34.3 33.3

262 44 43 42 41 40 39 38 37 36 35 34 33

254 43.7 42.7 41.7 40.7 39.7 38.7 37.7 36.7 35.7 34.7 33.7 –

246 43.4 42.4 41.4 40.4 39.4 38.4 37.4 36.4 35.4 34.4 33.4 –

238 43.2 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 –

230 42.9 41.9 40.9 39.9 38.9 37.9 36.9 35.9 34.9 33.9 – –

222 42.6 41.6 40.6 39.6 38.6 37.6 36.6 35.6 34.6 33.6 – –

214 42.2 41.2 40.2 39.2 38.2 37.2 36.2 35.2 34.2 33.2 – –
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Appendix E: CDMA Operating Frequency Information

 Appendix Content

CDMA Operating Frequency Programming Information – North
American PCS Bands E-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Introduction E-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1900 MHz PCS Channels E-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Calculating 1900 MHz Center Frequencies E-2. . . . . . . . . . . . . . . . . . . . . . 
800 MHz CDMA Channels E-4. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Calculating 800 MHz Center Frequencies E-4. . . . . . . . . . . . . . . . . . . . . . . 

CDMA Operating Frequency Programming Information – Korean Bands E-6. . . . 
1700 MHz PCS Channels E-6. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Calculating 1700 MHz Center Frequencies E-7. . . . . . . . . . . . . . . . . . . . . . E



Table of Contents  – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001

Notes

E



CDMA Operating Frequency Programming Information – North American
PCS Bands

Mar 2001 E-1SC�4812T CDMA BTS Optimization/ATP DRAFT

Introduction

Programming of each of the BTS BBX synthesizers is performed by the
BTS GLIs via the CHI bus. This programming data determines the
transmit and receive transceiver operating frequencies (channels) for
each BBX.

1900 MHz PCS Channels

Figure E-1 shows the valid channels for the North American PCS
1900 MHz frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-1: North American PCS 1900 MHz Frequency Spectrum (CDMA Allocation)
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Calculating 1900 MHz Center
Frequencies

Table E-1 shows selected 1900 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� TX = 1930 + 0.05 * Channel#
Example: Channel 262
TX = 1930 + 0.05*262 = 1943.10 MHz

� RX = TX – 80
Example: Channel 262
RX = 1943.10 – 80 = 1863.10 MHz

Actual frequencies used depend on customer CDMA system frequency
plan.

Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard band on
both sides of the carrier.

Minimum frequency separation required between any CDMA carrier and
the nearest NAMPS/AMPS carrier is 900 kHz (center-to-center).

Table E-1: 1900 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1931.25 1851.25

50 0032 1932.50 1852.50

75 004B 1933.75 1853.75

100 0064 1935.00 1855.00

125 007D 1936.25 1856.25

150 0096 1937.50 1857.50

175 00AF 1938.75 1858.75

200 00C8 1940.00 1860.00

225 00E1 1941.25 1861.25

250 00FA 1942.50 1862.50

275 0113 1943.75 1863.75

300 012C 1945.00 1865.00

325 0145 1946.25 1866.25

350 015E 1947.50 1867.50

375 0177 1948.75 1868.75

400 0190 1950.00 1870.00

425 01A9 1951.25 1871.25

450 01C2 1952.50 1872.50

475 01DB 1953.75 1873.75

500 01F4 1955.00 1875.00
. . . continued on next page
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Table E-1: 1900 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal       Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

525 020D 1956.25 1876.25

550 0226 1957.50 1877.50

575 023F 1958.75 1878.75

600 0258 1960.00 1880.00

625 0271 1961.25 1881.25

650 028A 1962.50 1882.50

675 02A3 1963.75 1883.75

700 02BC 1965.00 1885.00

725 02D5 1966.25 1886.25

750 02EE 1967.50 1887.50

775 0307 1968.75 1888.75

800 0320 1970.00 1890.00

825 0339 1971.25 1891.25

850 0352 1972.50 1892.50

875 036B 1973.75 1893.75

900 0384 1975.00 1895.00

925 039D 1976.25 1896.25

950 03B6 1977.50 1897.50

975 03CF 1978.75 1898.75

1000 03E8 1980.00 1900.00

1025 0401 1981.25 1901.25

1050 041A 1982.50 1902.50

1075 0433 1983.75 1903.75

1100 044C 1985.00 1905.00

1125 0465 1986.25 1906.25

1150 047E 1987.50 1807.50

1175 0497 1988.75 1908.75
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800 MHz CDMA Channels

Figure E-2 shows the valid channels for the North American cellular
telephone frequency spectrum. There are 10 CDMA wireline or
non–wireline band channels used in a CDMA system (unique per
customer operating system).

Figure E-2: North American Cellular Telephone System Frequency Spectrum (CDMA Allocation)
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Calculating 800 MHz Center
Frequencies

Table E-2 shows selected 800 MHz CDMA candidate operating
channels, listed in both decimal and hexadecimal, and the corresponding
transmit, and receive frequencies. Center frequencies (in MHz) for
channels not shown in the table may be calculated as follows:

� Channels 1–777
TX = 870 + 0.03 * Channel#
Example: Channel 262
TX = 870 + 0.03*262 = 877.86 MHz

� Channels 1013–1023
TX = 870 + 0.03 * (Channel# – 1023)
Example: Channel 1015
TX = 870 +0.03 *(1015 – 1023) = 869.76 MHz

� RX = TX – 45 MHz
Example: Channel 262
RX = 877.86 –45 = 832.86 MHz

Table E-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

1 0001 870.0300 825.0300

25 0019 870.7500 825.7500
. . . continued on next page
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Table E-2: 800 MHz TX and RX Frequency vs. Channel

Channel Number
Decimal   Hex

Receive Frequency (MHz)
Center Frequency

Transmit Frequency (MHz)
Center Frequency

50 0032 871.5000 826.5000

75 004B 872.2500 827.2500

100 0064 873.0000 828.0000

125 007D 873.7500 828.7500

150 0096 874.5000 829.5000

175 00AF 875.2500 830.2500

200 00C8 876.0000 831.0000

225 00E1 876.7500 831.7500

250 00FA 877.5000 832.5000

275 0113 878.2500 833.2500

300 012C 879.0000 834.0000

325 0145 879.7500 834.7500

350 015E 880.5000 835.5000

375 0177 881.2500 836.2500

400 0190 882.0000 837.0000

425 01A9 882.7500 837.7500

450 01C2 883.5000 838.5000

475 01DB 884.2500 839.2500

500 01F4 885.0000 840.0000

525 020D 885.7500 840.7500

550 0226 886.5000 841.5000

575 023F 887.2500 842.2500

600 0258 888.0000 843.0000

625 0271 888.7500 843.7500

650 028A 889.5000 844.5000

675 02A3 890.2500 845.2500

700 02BC 891.0000 846.0000

725 02D5 891.7500 846.7500

750 02EE 892.5000 847.5000

775 0307 893.2500 848.2500

NOTE
Channel numbers 778 through 1012 are not used.

1013 03F5 869.7000 824.7000

1023 03FF 870.0000 825.0000
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1700 MHz PCS Channels

Figure E-3 shows the valid channels for the 1700 MHz PCS frequency
spectrum. The CDMA channels are spaced in increments of 25 (25, 50,
75, . . . 575) across the CDMA band.
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Figure E-3: 1700 MHz PCS Frequency Spectrum (CDMA Allocation)

 . . . continued on next page
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Calculating 1700 MHz Center
Frequencies

Center frequency for channels may be calculated as follows:

Direction Formula Example

TX 1840 + (0.05 * Channel#) Channel: 1840 + (0.05 + 25) = 1841.25

RX 1750 + (0.05 * Channel#) Channel: 1750 + (0.05 + 25) = 1751.25

– Actual frequencies used depend on customer CDMA system
frequency plan.

– Each CDMA channel requires a 1.77 MHz frequency segment. The
actual CDMA carrier is 1.23 MHz wide, with a 0.27 MHz guard
band on both sides of the carrier

– Minimum frequency separation required between any CDMA
carrier and the nearest NAMPS/AMPS carrier is 900 kHz (center to
center).

Table E-3: 1700 MHz TX and RX Frequency vs. Channel (Korean Bands)

Channel Number
Decimal       Hex

Transmit Frequency (MHz)
Center Frequency

Receive Frequency (MHz)
Center Frequency

25 0019 1841.25 1751.25

50 0032 1842.50 1752.50

75 004B 1843.75 1753.75

100 0064 1845.00 1755.00

125 007D 1846.25 1756.25

150 0096 1847.50 1757.50

175 00AF 1848.75 1758.75

200 00C8 1850.00 1760.00

225 00E1 1851.25 1761.25

250 00FA 1852.50 1762.50

275 0113 1853.75 1763.75

300 012C 1855.00 1765.00

325 0145 1856.25 1766.25

350 015E 1857.50 1767.50

375 0177 1858.75 1768.75

400 0190 1860.00 1770.00

425 01A9 1861.25 1771.25

450 01C2 1862.50 1772.50

475 01DB 1863.75 1773.75

500 01F4 1865.00 1775.00

525 020D 1866.25 1776.25

550 0226 1867.50 1777.50

575 023F 1868.75 1778.75
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Appendix F: PCS Interface Setup for Manual Testing
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Test Equipment Setup F-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Purpose F-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Equipment Warm up F-1. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Prerequisites F-2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
HP8921A System Connectivity Test F-2. . . . . . . . . . . . . . . . . . . . . . . . . . . 
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Purpose

This section covers other test equipment and peripherals not covered in
Chapter 3. Procedures for the manual testing are covered here, along
with procedures to calibrate the TX and RX cables using the signal
generator and spectrum analyzer.

Equipment Warm up

Warm-up BTS equipment for a minimum of 60 minutes
prior to performing the BTS optimization procedure. This
assures BTS site stability and contributes to optimization
accuracy. (Time spent running initial power-up, hardware/
firmware audit, and BTS download counts as warm-up
time.)

IMPORTANT

*

If any piece of test equipment (i.e., test cable, RF adapter)
has been replaced, re-calibration must be performed.
Failure to do so could introduce measurement errors,
resulting in incorrect measurements and degradation to
system performance.

CAUTION

Calibration of the communications test set (or equivalent
test equipment) must be performed at the site before
calibrating the overall test set. Calibrate the test equipment
after it has been allowed to warm-up and stabilize for a
minimum of 60 minutes.

IMPORTANT

*
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Prerequisites

Prior to performing any of these procedures, all preparations for
preparing the LMF, updating LMF files, and any other pre-calibration
procedures, as stated in Chapter 3, must have been completed.

HP8921A System Connectivity
Test

Follow the steps in Table F-1 to verify that the connections between the
PCS Interface and the HP8921A are correct, and cables are intact. The
software also performs basic functionality checks of each instrument.

Disconnect other GPIB devices, especially system
controllers, from the system before running the
connectivity software.

IMPORTANT

*

Table F-1: System Connectivity

Step Action

* IMPORTANT
– Perform this procedure after test equipment has been allowed to warm–up and stabilize for a

minimum of 60 minutes.

1 Insert HP 83236A Manual Control/System card into memory card slot.

2 Press the [PRESET] pushbutton.

3 Press the Screen Control [TESTS] pushbutton to display the “Tests” Main Menu screen.

4 Position the cursor at Select Procedure Location and select by pressing the cursor control knob.

In the Choices selection box, select Card.

5 Position the cursor at Select Procedure Filename and select by pressing the cursor control knob.

In the Choices selection box, select SYS_CONN.

6 Position the cursor at RUN TEST and select it.

The software will prompt you through the connectivity setup.

7 When the test is complete, position the cursor on STOP TEST and select it; OR press the [K5]
pushbutton.

8 To return to the main menu, press the [K5] pushbutton.
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Manual Cable Calibration
using HP8921 with HP PCS 
Interface (HP83236)

Perform the procedure in Table F-2 to calibrate the test equipment using
the HP8921 Cellular Communications Analyzer equipped with the
HP83236 PCS Interface.

This calibration method must be executed with great care.
Some losses are measured close to the minimum limit of
the power meter sensor (–30 dBm).

NOTE

Prerequisites

Ensure the following prerequisites have been met before proceeding:

� Test equipment to be calibrated has been connected correctly for cable
calibration.

� Test equipment has been selected and calibrated.

Refer to Figure F-1 for location of the components on the PCS Interface
and Communications Test Set.

Table F-2: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

NOTE
Verify that GPIB controller is turned off.

1 Insert HP 83236A Manual Control System card into memory card slot (see Figure F-1).

2 Press the Preset pushbutton.

3 Under Screen Controls, press the TESTS pushbutton to display the TESTS (Main Menu) screen.

4 Position the cursor at Select Procedure Location and select it. In the Choices selection box, select
CARD.

5 Position the cursor at Select Procedure Filename and select it. In the Choices selection box, select
MANUAL.

6 Position the cursor at RUN TEST and select it. HP must be in Control Mode Select YES.

7 If using HP 83236A:
Set channel number=<chan#>:

– Position cursor at Channel
Number and select it.

– Enter the chan# using the numeric
keypad; press [Enter] and the
screen will go blank.

– When the screen reappears, the
chan# will be displayed on the
channel number line.

If using HP 83236B:
Set channel frequency:

– Position cursor at Frequency Band and press Enter.

– Select User Defined Frequency.

– Go Back to Previous Menu.

– Position the cursor to 83236 generator frequency and
enter actual RX frequency.

– Position the cursor to 83236 analyzer frequency and
enter actual TX frequency.

. . . continued on next page

F



Test Equipment Setup  – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001F-4

Table F-2: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

8 Set RF Generator level:

– Position the cursor at RF Generator Level and select it.

– Enter –10 using the numeric keypad; press [Enter] and the screen will go blank.

– When the screen reappears, the value –10 dBm will be displayed on the RF Generator Level line.

9 Set the user fixed Attenuation Setting to 0 dBm:

– Position cursor at Analyzer Attenuation and select it
– Position cursor at User Fixed Atten Settings and select it.

– Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Record the HP83236 Generator Frequency Level:

Record the HP83236B Generator Frequency Level:

– Position cursor at Show Frequency and Level Details and select it.
– Under HP83236 Frequencies and Levels, record the Generator Level.
– Under HP83236B Frequencies and Levels, record the Generator Frequency Level

(1850 – 1910 MHz for 1.9 GHz or 1750 – 1780 for 1.7 GHz).

– Position cursor at Prev Menu and select it.

12 Click on Pause for Manual Measurement.

13 Connect the power sensor directly to the RF OUT ONLY port of the PCS Interface.

14 On the HP8921A, under To Screen, select CDMA GEN.

15 Move the cursor to the Amplitude field and click on the Amplitude value.

16 Increase the Amplitude value until the power meter reads 0 dBm ±0.2 dB.

NOTE
The Amplitude value can be increased coarsely until 0 dBM is reached; then fine tune the amplitude
by adjusting the Increment Set to 0.1 dBm and targeting in on 0 dBm.

17 Disconnect the power sensor from the RF OUT ONLY port of the PCS Interface.

* IMPORTANT
The Power Meter sensor’s lower limit is –30 dBm. Thus, only components having losses ≤30 dB
should be measured using this method. For further accuracy, always re-zero the power meter
before connecting the power sensor to the component being calibrated. After connecting the
power sensor to the component, record the calibrated loss immediately.

18 Disconnect all components in the test setup and calibrate each one separately by connecting each
component, one-at-a-time, between the RF OUT ONLY PORT and the power sensor (see Figure F-1,
Setups A, B, or C). Record the calibrated loss value displayed on the power meter.

� Example: (A) Test Cable(s) = –1.4 dB
(B) 20 dB Attenuator = –20.1 dB
(B) Directional Coupler = –29.8 dB

. . . continued on next page
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Table F-2: Manual Cable Calibration Test Equipment Setup (using the HP PCS Interface)

Step Action

19 After all components are calibrated, reassemble all components together and calculate the total test
setup loss by adding up all the individual losses:
� Example: Total test setup loss = –1.4 –29.8 –20.1 = –51.3 dB.

This calculated value will be used in the next series of tests.

20 Under Screen Controls press the TESTS button to display the TESTS (Main Menu) screen.

21 Select Continue (K2).

22 Select RF Generator Level and set to –119 dBm.

23 Click on Pause for Manual Measurement.

24 Verify the HP8921A Communication Analyzer/83203A CDMA interface setup is as follows (fields
not indicated remain at default):

� Verify the GPIB (HP–IB) address:

– under To Screen, select More

– select IO CONFIG

– Set HP–IB Adrs to 18

– set Mode to Talk&Lstn

� Verify the HP8921A is displaying frequency (instead of RF channel)

– Press the blue [SHIFT] button, then press the Screen Control [DUPLEX] button; this switches to
the CONFIG (CONFIGURE) screen.

– Use the cursor control to set RF Display to Freq

25 Refer to Table 3-29 for assistance in manually setting the cable loss values into the LMF.
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Figure F-1: Calibrating Test Setup Components
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HP PCS Interface Test Equipment
Setup for Manual Testing

Follow the procedure in Table F-3 to setup the HP PCS Interface Box for
manual testing.

Table F-3: HP PCS Interface Test Equipment Setup for Manual Testing

� Step Action

NOTE
Verify GPIB controller is turned off.

1 Insert HP83236B Manual Control/System card into the memory card slot.

2 Under Screen Controls, press the [TESTS] push-button to display the TESTS (Main Menu)
screen.

3 Position the cursor at Select Procedure Location and select. In the Choices selection box, select
CARD.

4 Position the cursor at Select Procedure Filename and select. In the Choices selection box, select
MANUAL.

5 Position the cursor at RUN TEST and select OR press the K1 push-button.

6 Set channel number=<chan#>:

– Position cursor at Channel Number and select.

– Enter the chan# using the numeric keypad and then press [Enter] (the screen will blank).

– When the screen reappears, the chan# will be displayed on the channel number line.

* IMPORTANT
If using a TMPC with Tower Top Amplifier (TTA) skip Step 7.

7 � Set RF Generator level= –119 dBm + Cal factor

Example: –119 dBm + 2 dB = –117 dBm

� Continue with Step 9 (skip Step 8).

8 Set RF Generator level= –116 dBm + Cal factor.

Example: –116 dBm + 2 dB = –114 dBm

9 Set the user fixed Attenuation Setting to 0 dB:

– Position cursor at RF Generator Level and select.

– Position  cursor at User Fixed Atten Settings and select.

– Enter 0 (zero) using the numeric keypad and press [Enter].

10 Select Back to Previous Menu.

11 Select Quit, then select Yes.
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Calibrating Test Cable Setup
using Advantest R3465

Be sure the GPIB Interface is OFF for this procedure.

NOTE

Perform the procedure in Table F-4 to calibrate the test cable setup using
the Advantest R3465. Advantest R3465 Manual Test setup and
calibration must be performed at both the TX and RX frequencies.

Table F-4: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

* IMPORTANT
– This procedure can only be performed after test equipment has been allowed to warm–up and

stabilize for a minimum of 60 minutes.

1 Press the SHIFT and the PRESET keys located below the display

2 Press the ADVANCE key in the MEASUREMENT area of the control panel.

3 Select the CDMA Sig CRT menu key

4 Select the Setup CRT menu key

5 Using the vernier knob and the cursor keys set the following parameters

NOTE
Fields not listed remain at default

Generator Mode: SIGNAL

Link: FORWARD

Level Unit: dBm

CalCorrection: ON

Level Offset: OFF

6 Select the return CRT menu key

7 Press FREQ key in the ENTRY area

8 Set the frequency to the desired value using the keypad entry keys

9 Verify that the Mod CRT menu key is highlighting OFF; if not, press the Mod key to toggle it OFF.

10 Verify that the Output CRT menu key is highlighting OFF; if not, press the Output key to toggle it
OFF.

11 Press the LEVEL key in the ENTRY area.

12 Set the LEVEL to 0 dBm using the key pad entry keys.

13 Zero power meter. Next connect the power sensor directly to the “RF OUT” port on the R3561L
CDMA Test Source Unit.

14 Press the Output CRT menu key to toggle Output to ON.

. . . continued on next page
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Table F-4: Procedure for Calibrating Test Cable Setup Using Advantest R3465

Step Action

15 Record the power meter reading  ________________________

16 Disconnect the power meter sensor from the R3561L RF OUT jack.

* IMPORTANT
The Power Meter sensor’s lower limit is –30 dBm.  Thus, only components having losses < 30 dB
should be measured using this method. For best accuracy, always re–zero the power meter before
connecting the power sensor to the component being calibrated.  Then, after connecting the
power sensor to the component, record the calibrated loss immediately.

17 Disconnect all components in the the test setup and calibrate each one separately.  Connect each
component one–at–a–time between the “RF OUT” port and the power sensor (see Figure F-2, “Setups
A, B, and C”). Record the calibrated loss value displayed on the power meter for each connection.

Example: (A) 1st Test Cable =  –0.5 dB
(B) 2nd Test Cable =  –1.4 dB
(C) 20 dB Attenuator =  –20.1 dB
(D) 30 dB Directional Coupler =  –29.8 dB

18 Press the Output CRT menu key to toggle Output OFF.

19 Calculate the total test setup loss by adding up all the individual losses:

Example: Total test setup loss  =  0.5 + 1.4 + 20.1 + 29.8  =  51.8 dB

This calculated value will be used in the next series of tests.

20 Press the FREQ key in the ENTRY area

21 Using the keypad entry keys, set the test frequency to the RX frequency

22 Repeat steps 9 through 19 for the RX frequency.

23 Refer to Table 3-29 for assistance in manually setting the cable loss values into the LMF.
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Figure F-2: Cable Calibration using Advantest R3465
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Purpose

The following procedures will verify that the Voltage Standing Wave
Ratio (VSWR) of all antennas and associated feed lines fall within
acceptable limits. The tests will be performed on all antennas in a
sequential manner (i.e., ANT 1, then ANT 2) until all antennas/feedlines
have been verified.

These procedures should be performed periodically by measuring each
respective antenna’s VSWR (reflected power) to verify that the antenna
system is within acceptable limits. This will ensure continued peak
system performance.

The antenna VSWR will be calculated at the CDMA carrier frequency
assigned to each antenna. Record and verify that they meet the test
specification of less than or equal to 1.5:1.

It is recommended that the installer be familiar with the
following procedure in its entirety before beginning the
actual procedure. Ensure that the entire site is currently not
in service.

IMPORTANT

*

This test is used to test RX antennas by substituting RX
frequencies for TX frequencies.

NOTE

Study the site engineering documents and perform the following tests
only after first verifying that the RF cabling configuration required to
interconnect the BTS frames and antennas meet requirements called out
in the BTS Installation Manual.

Test equipment

The following pieces of test equipment will be required to perform this
test:

� LMF

� Directional coupler

� Communications test set

Prior to performing antenna tests, insure that no CDMA
BBX channels are keyed. Failure to do so could result in
personal injury or serious equipment damage.

WARNING
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Equipment Setup – HP Test
Set 

Follow the steps in Table G-1 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table G-1: VSWR Measurement Procedure – HP Test Set

Step Action HP TEST SET

1 If you have not already done so, refer to the procedure in Table 3-2 on page 3-5 to set up test
equipment & interface the LMF computer to the BTS.

2 For manual VSWR testing, using external directional coupler, refer to Figure G-1 (1700/1900 MHz)
or Figure G-2 (800 MHz).

– Connect the communications test set RF OUT ONLY port to the INPUT port of the directional
coupler.

– Connect the RF IN/OUT port of the communication test set to the reverse (RVS) port on the
directional coupler. Terminate the forward port with a 50 ohm load.

– Install the antenna feed line to the output port on the directional coupler.

NOTE
Manual Communications Analyzer test setup (fields not indicated remain at default):

� Set screen to RF GEN.

– For 1900 MHz systems, set the RF Gen Freq to center frequency of actual CDMA carrier
between 1930–1990 MHz for TX and 1850–1910 MHz for RX. For 800 MHz systems, set the
RF Gen Freq to center frequency of actual CDMA carrier between 869–894 MHz for TX and
824–849 MHz for RX. For 1700 MHz systems, set the RF Gen Freq to center frequency of
actual CDMA carrier between 1840–1870 MHz for TX and 1750–1780 MHz for RX.

– Set Amplitude to –30 dBm.

– Set Output Port to RF OUT.

– Set AFGen1 & AFGen2 to OFF.

3 Remove the antenna feed line and install an “RF short” onto the directional coupler output port.

NOTE
Set–up communication test set as follows (fields not indicated remain at default):

� Set  screen to SPEC ANL.

– Under Controls, set input port to ANT.

– Set Ref Level to –40 dBm.

– Under Controls, select Main, select Auxiliary.

– Under Controls, select AVG. Set Avg = 20.

4 – Record the reference level on the communications analyzer and Note as PS for reference. 

– Replace the short with the antenna feedline. Record the reference level on the communications
analyzer and Note for as PA reference.

– Record the difference of the two readings in dB.

. . . continued on next page
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Table G-1: VSWR Measurement Procedure – HP Test Set

Step HP TEST SETAction

5 Calculate the VSWR per the equation shown to the right.
Where:

RL(dB) = PA(dBm) – PS(dBm) 
PA = Power reflected from antenna
PS = Power reflected from short

A calculated value of  –13.98 dB equates to VSWR of better than 1.5:1.

VSWR ���
�

�

1 � 10
RL
20

1 – 10
RL

20

��
�

�

6 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in–line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

7 Repeat steps 2 through 6 for all remaining TX sectors/antennas.

8 Repeat steps 2 through 6 for all remaining RX sectors/antennas.

 

Figure G-1: Manual VSWR Test Setup Using HP8921 Test Set (1700/1900 MHz)
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Figure G-2: Manual VSWR Test Setup Using HP8921 Test Set (800 MHz)
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Equipment Setup – Advantest
Test Set

Follow the steps in Table G-2 to set up test equipment required to
measure and calculate the VSWR for each antenna.

Table G-2: VSWR Measurement Procedure – Advantest Test Set

Step Action ADVANTEST

1 If you have not already done so, refer to the procedure in Table 3-2 on page 3-5 to set up test
equipment and interface the LMF computer to the BTS.

2 For manual VSWR testing using external directional coupler, refer to Figure G-3.

– Connect the communications test set RF OUT port to the input port of the directional coupler.

– Connect the INPUT port of the communication test set to the forward port on the directional
coupler. Terminate the forward port with a 50 Ohm load.

– Connect the RF short to the directional coupler output port.

. . . continued on next page
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Table G-2: VSWR Measurement Procedure – Advantest Test Set

Step ADVANTESTAction

3 Preform the following to instruct the calibrated test set to generate a CDMA RF carrier (RVL call)
with all zero longcode at the assigned RX frequency at –10 dBm:

� Push the ADVANCE Measurement key.

� Push the CDMA Sig CRT menu key.

� Push the FREQ Entry key:

– For 1900 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1930–1990 MHz for  TX and 1850–1910 MHz for RX.

– For 800 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
869–894 MHz for  TX and 824–849 MHz for RX.

– For 1700 MHz systems, set RF Gen Freq to center frequency of actual CDMA carrier between
1840–1870 MHz for  TX and 1750–1780 MHz for RX.

� Push the LEVEL Entry key; set to 0 dBm (by entering 0 and pushing the –dBm key).

� Verify  that ON is active in the Output CRT menu key.

� Verify  that OFF is active in the Mod CRT menu key.

� Push the CW Measurement key.

� Push the FREQ Entry key.

– Push the more 1/2 CRT menu key.

– Set Preselect CRT menu key to 3.0G.

� Push the Transient Measurement key.

– Push the Tx Power CRT menu key.

– Push the LEVEL entry key (set to 7 dBm by entering 7 and pushing the the dBm key).

– Set Avg Times CRT menu key to ON. Set to 20 (by entering 20 and pushing the Hz ENTER
key).

� Push the REPEAT Start key to take the measurement.

4 Record the Burst Power display on the communications analyzer and Note as PS for reference.

5 Install the antenna feedline to the output port of the directional coupler.

6 � Push the Auto Level Set CRT menu key.

� Push the REPEAT Start key to take the measurement.

7 Record the Burst Power on the communications analyzer and Note as PA level for reference.

Record the difference of the two readings in dBm.

8 Calculate the VSWR per the equation shown to the right.
Where:

RL(dB) = PA(dBm) – PS(dBm) 
PA = Power reflected from antenna
PS = Power reflected from short

A calculated value of  –13.98 dB equates to VSWR of better than 1.5:1.
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. . . continued on next page
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Table G-2: VSWR Measurement Procedure – Advantest Test Set

Step ADVANTESTAction

9 If the readings indicate a potential problem, verify the physical integrity of all cables (including any
in–line components, pads, etc.) and associated connections up to the antenna. If problem still persists,
consult antenna OEM documentation for additional performance verification tests or replacement
information.

10 Repeat steps 2 through 9 for all remaining TX sectors/antennas.

11 Repeat steps 2 through 9 for all remaining RX sectors/antennas.

 

Figure G-3: Manual VSWR Test Setup Using Advantest R3465
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Download ROM Code

ROM code can be downloaded to a device that is in any state. After the
download is started, the device being downloaded changes to
OOS_ROM (blue) and remains OOS_ROM (blue). The same R–level
RAM code must then be downloaded to the device. This procedure
includes steps for both the ROM code download and the RAM code
download.

ROM code files cannot be selected automatically. The ROM code file
must be selected manually. Follow the procedure in Table H-1 to
download ROM code.

Prerequisite

� ROM and RAM code files exist for the device to be downloaded.

The R–level of the ROM code to be downloaded must be
the same as the R–level of the ROM code for other devices
in the BTS. Code must not be mixed in a BTS. This
procedure should only be used to upgrade replacement
devices for a BTS and it should not be used to upgrade all
devices in a BTS. If a BTS is to be upgraded from one
R–level to another, the optimization and ATP procedures
must first be performed with the BTS in the original
configuration. The upgrade should then be done by the
CBSC.

CAUTION

Table H-1: Download ROM Code

Step Action

NOTE
ROM code files cannot be selected automatically. The ROM code file must be selected manually.

1 Click on the device to be downloaded.

2 Click on the Device menu.

3 Click on the Status menu item.

A status report window appears.

4 Make a note of the number in the HW Bin Type column.

5 Click on the OK button to dismiss the status report window.

6 Click on the Download Code Manual menu item.

A file selection window appears.

7 Double–click on the version folder that contains the desired ROM code file.

8 Double–click on the Code folder.

A list of ROM and RAM code files is displayed.
. . . continued on next page
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Table H-1: Download ROM Code

Step Action

! CAUTION
A ROM code file having the correct hardware binary type (HW Bin Type) needs to be chosen. The
hardware binary type (last four digits in the file name) was determined in step 4. Unpredictable results
can happen and the device may be damaged (may have to be replaced) if a ROM code file with wrong
binary type is downloaded.

9 Choose a ROM code file having the correct hardware binary type (HW Bin Type).
The hardware binary type (last four digits in the file name) was determined in step 4.

10 Click on the ROM code file that matches the device type and HW Bin Type (e.g., bbx_rom.bin.0604
for a BBX having a HW Bin Type of 0604).

The file should be highlighted.

11 Click on the Load button.

A status report window displays the result of the download.

12 Click on the Ok button to close the status report window.

13 Click on the Util menu.

14 Select the Tools menu item.

15 Click on the Update NextLoad menu item.

16 Select the version number of the folder that was used for the ROM code download.

17 Click on the Save button.

A pop–up message indicates that the CDF file has been updated.

18 Click on the OK button to dismiss the pop–up message.

19 Click on the device that was downloaded with ROM code.

20 Click on the Device menu.

21 Click on the Download Code menu item to download RAM code.

A status report window displays the result of the download.

NOTE
Data is automatically downloaded to GLI devices when the RAM code is downloaded. Use the
Download Data procedure to download data to other device types after they have been upgraded.

22 Click on the Ok button to close the status report window.

The downloaded device should be OOS_RAM (yellow) unless it is a GLI in which case it should be
INS (green).

23 Click on the device that was downloaded.

24 Click on the Device menu.

25 Click on the Status menu item.

Verify that the status report window displays the correct ROM and RAM version numbers.

26 Click on the Ok button to close the status report window.
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Appendix I: In–Service Calibration
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Purpose

This procedure is a guide to expanding your system with multiple
carriers while the system remains in service. This procedure also allows
you to perform on site maintenance (replace defective boards and
recalibrate) while the remainder of the site stays in service.

Motorola recommends that you perform this procedure during a
maintenance window.

This procedure cannot be performed on BTSs with 4–to–1 combiners.
The procedure can only be performed on one side of the BTS at one
time. That is, LPAs 1, 2 ,3, 7, 8, 9 (feed antennas 1, 2, 3) can be
calibrated while LPAs 6, 7, 8, 10, 11, 12 (feed antennas 4, 5, 6) remain
in service and vice versa.

Equipment Warm up

Calibration of the communications test set (or equivalent
test equipment) must be performed at the site before
calibrating the overall test set. Calibrate the test equipment
after it has been allowed to warm-up and stabilize for a
minimum of 60 minutes.

IMPORTANT

*

If any piece of test equipment (i.e., test cable, RF adapter)
has been replaced, re-calibration must be performed.
Failure to do so could introduce measurement errors,
causing incorrect measurements and degradation to system
performance.

CAUTION
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Power Delta Calibration
Introduction

The In–service calibration procedure has several differences from a
normal calibration procedure. One of these is the use of a spectrum
analyzer instead of a power meter to measure power. Power meters are
broadband measurement devices and cannot be used to measure power
during In–service Calibration since other carriers are operating. A
spectrum analyzer can be used because it measures power at a given
frequency. However, measuring power using a spectrum analyzer is less
accurate than using a power meter. Therefore, you must compensate for
the difference (delta) between the power meter and the spectrum
analyzer.

HP8921A Power Delta
Calibration

Use the HP8921A Spectrum Analyzer to measure power during
In–Service Calibration for 800 MHz systems. After the offset value has
been calculated, add it to the TX cable loss value.

Follow the procedure in Table I-1 to perform the HP8921A Power Delta
Calibration procedure.

This procedure requires two HP8921As.

NOTE

Table I-1: HP8921A Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8921A Duplex Out port and the HP437B power sensor (see
Figure I-1).

2 Set the HP8921A signal source as follows:

– Measure mode to CDMA Generator
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

. . . continued on next page
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Table I-1: HP8921A Power Delta Calibration Procedure

Step Action

5 Turn off the source HP8921A signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8921A for convenience in the following steps.

6 Connect the short RF cable between the source HP8921A Duplex Out port and the measuring
HP8921A RF–IN port (see Figure I-2).

7 Ensure that the source HP8921A settings are the same as in Step 2.

8 Set the measuring HP8921A as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Analyzer Direction to Fwd

9 Turn on the source HP8921A signal output.

10 Measure and record the channel power reading on the measuring HP8921A as result
B ________________________.

11 Turn off the source HP8921A signal output and disconnect the equipment.

12 Compute the delta between HP437B and HP8921A using the following formula:

Delta = A – B
Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table I-4).
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Figure I-1: Delta Calibration Setup – HP8921A to HP437B
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Figure I-2: Delta Calibration Setup – HP8921A to HP8921A
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Advantest R3465 Power Delta
Calibration

Follow the procedure in Table I-2 to perform the Advantest 3465 Power
Delta Calibration procedure.

Table I-2: Advantest Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

On the Advantest R3465:

1 Press the SHIFT and the PRESET keys located below the CRT display.

2 Press the ADVANCE key in the Measurement area of the control panel.

3 Press the CDMA Sig CRT menu key.

4 Press the FREQ key in the Entry area of the control panel.

. . . continued on next page
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Table I-2: Advantest Power Delta Calibration Procedure

Step Action

5 Set the frequency to the desired value using the keypad entry keys.

6 Press the LEVEL key in the Entry area of the control panel.

7 Set the LEVEL to 0 dBm using the keypad entry keys.

8 Verify the Mod CRT menu key is highlighting OFF, if not press the Mod key to toggle it OFF.

9 Verify the Output CRT menu key is highlighting OFF, if not press the Output key to toggle it OFF.

On the HP 437 Power Meter:

10 Zero the Power Meter prior to connecting the power sensor to the RF cable from the signal generator.

* IMPORTANT
For best accuracy, always re–zero the power meter before connecting the power sensor to the
component being calibrated.

11 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the power sensor,
refer to Figure I-3.

12 Press the Output CRT menu key to toggle the Output to ON.

13 Record the Power Meter reading as result A ________________________.

14 Press the Output CRT menu key to toggle the Output to OFF.

15 Connect the RF cable from the R3561L CDMA Test Source Unit RF OUT port to the Spectrum
Analyzer INPUT Port, refer to Figure I-4.

16 Press the Output CRT menu key to change the Output to ON.

17 Press the CW key in the Measurement area of the control panel.

18 Press the LEVEL key in the Entry area of the control panel.

19 Set the REF LEVEL to 10 dBm using the keypad entry keys.

20 Press the dB/div CRT menu key.

21 Press the 10 dB/div CRT menu key.

22 Press the FREQ key in Entry area of the control panel.

23 Set the frequency to the desired value using the keypad entry keys.

24 Press the more 1/2 CRT menu key.

25 Press the Preselector CRT menu key to highlight 3.0G.

26 Press the FORMAT key in the Display Control area of the control panel.

27 Press the TRACE CRT menu key.

28 Press the AVG A CRT menu key.

29 Set AVG to 20 using keypad entry keys.

. . . continued on next page
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Table I-2: Advantest Power Delta Calibration Procedure

Step Action

30 Press the return CRT menu key.

31 Press the SPAN key in the Entry area of the control panel.

32 Press the Zero Span CRT menu key.

33 Press the BW key in the Entry area of the control panel.

34 Press the RBW CRT menu key to highlight MNL. using keypad entry keys enter 30 kHz.

35 Set RBW to 30 kHz using keypad entry keys.

36 Press the VBW CRT menu key to highlight MNL.

37 Set VBW to 1 MHz using keypad entry keys.

38 Press the Marker ON key in the Display Control area of the control panel.

39 Record the Marker Level reading as result B ________________________.

40 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table I-4).

 

Figure I-3: Delta Calibration Setup – R3561L to HP437B
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Figure I-4: Delta Calibration Setup – R3561L to R3465
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HP8935 Power Delta
Calibration

Follow the procedure in Table I-3 to perform the HP8935 Power Delta
Calibration procedure.

Table I-3: HP8935 Power Delta Calibration Procedure

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Connect a short RF cable between the HP8935 Duplex Out port and the HP437B power sensor (see
Figure I-5).

2 Set the HP8935 signal source as follows:

– Measure mode to CDMA Gen
– Frequency to the CDMA Calibration target frequency

– CW RF Path to IQ

– Output Port to Dupl

– Data Source to Random

– Amplitude to 0 dBm

3 Measure and record the power value reading on the HP437B Power Meter.

4 Record the Power Meter reading as result A ________________________.

5 Turn off the source HP8935 signal output, and disconnect the HP437B.

NOTE
Leave the settings on the source HP8935 for convenience in the following steps.

6 Connect the short RF cable between the source HP8935 Duplex Out port and the RF–IN/OUT port
(see Figure I-6).

7 Ensure that the source HP8935 settings are the same as in Step 2.

. . . continued on next page I



Power Delta Calibration – continued

DRAFT
SC�4812T CDMA BTS Optimization/ATP Mar 2001I-8

Table I-3: HP8935 Power Delta Calibration Procedure

Step Action

8 Set the measuring HP8935 as follows:

– Measure mode to CDMA Anl
– Frequency to the CDMA calibration target frequency

– Input Attenuation to 0 dB

– Input port to RF–IN

– Gain to Auto

– Anl Dir to Fwd

9 Turn on the source HP8935 signal output.

10 Set the Chn Pwr Cal to Calibrate and select to calibrate.

11 Measure and record the channel power reading on the measuring HP8935 as result
B ________________________.

12 Turn off the source HP8935 signal output and disconnect the equipment.

13 Calculate the Power Calibration Delta value. The delta value is the power meter measurement minus
the Advantest measurement.

Delta = A – B

Example: Delta = –0.70 dBm – (–1.25 dBm) = 0.55 dBm

Example: Delta = 0.26 dBm – 0.55 dBm = –0.29 dBm

These examples are included to show the mathematics and do not represent actual readings.

NOTE
Add this delta value to the TX Cable Loss value during In–Service Calibration (see Step 4 in
Table I-4).

 

Figure I-5: Delta Calibration Setup – HP8935 to HP437B
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Figure I-6: Delta Calibration Setup – HP8935 to HP8935
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In–Service Calibration

This feature does NOT have fault tolerance at this time.
The system has no safe–guards to stop you from doing
something that will take the BTS out of service. If
possible, perform this procedure during a maintenance
window.

Follow the procedures in this section precisely, otherwise
the entire BTS will most likely go OUT OF SERVICE. 

At the CBSC, only perform operations on expansion
hardware when it is in the OOS_MANUAL state.

The operator must be trained in the LMF operation prior to
performing this procedure.

IMPORTANT

*

Prerequisites
� Expansion hardware has been added in the CBSC database, and the

CDF file has been generated.

� The expansion devices have been inserted into the C–CCP cage and
are in the OOS_MANUAL state at the CBSC.

� The site specific cdf (with the expansion hardware) and cal files have
been loaded onto the LMF.

� The LMF has the same code and dds files as the CBSC to download.

Do not download code or data to any cards other than those
you are working on. Downloading code or data to other
cards will take the site OUT OF SERVICE.

The code file version numbers must match the version
numbers on the other cards in the frame. If the numbers do
not match, the site may go OUT OF SERVICE.

The BTS–#.cdf, CBSC–#.cdf, and CAL files for this BTS
must have come from the CBSC.

IMPORTANT

*

� Test equipment has been configured per Figure I-7 or Figure I-8.

� An RFDS (or at a minimum a directional coupler), whose loss is
already known, must be in line to perform the in–service calibration.

� Test equipment has been calibrated after 1 hour warm up.

� A short RF cable and two BNC–N adapters are available to perform
Cable Calibration.

 . . . continued on next page
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� The Power Delta Calibration has been performed (see Table I-1,
Table I-2, or Table I-3).
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Follow the procedure in Table I-4 to perform the In–Service Calibration.

Table I-4: In–Service Calibration

Step Action

* IMPORTANT
Perform this procedure after test equipment has been allowed to warm–up and stabilize for a minimum
of 60 minutes.

1 Set up the LMF for In–Service Calibration:

– Start the LMF by double–clicking the LMF icon on the Windows desktop.

– Click Options>LMF Options from the menu bar at the login screen.

– Check only the applicable spectrum analyzer check box on the Test Equipment tab.
Ensure that the GPIB address is 18.

– Uncheck any other other equipment that is selected.

– Click the Apply button.

– Select the BTS Options tab in the LMF Option window.

– Check the In–Service Calibration check box.

– Click the Apply button.

– Click the Dismiss button to close the LMF Option window.

2 Login to the target BTS:

– Select the target BTS icon.

– Click the Login button at the login screen.

3 Measure the Cable Loss using the Cable Calibration function:

– Click Util>Cable Calibration from the menu bar at the main window.

– Set the desired channel(s) and select TX and RX CABLE CAL at the cable calibration pop up
window.

– Click the OK button to perform cable calibration.

– Follow the on–screen instructions to complete the cable loss measurement.

NOTE
– The measured value is input automatically to the cable loss file.

– To view the cable loss file, click Util>Examine>Cable Loss.

. . . continued on next page
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Table I-4: In–Service Calibration

Step Action

4 Add the spectrum analyzer power delta to the Cable Loss.

– To view the cable loss file, click Util>Examine>Cable Loss.

– Add the value computed in Table I-1, Table I-2, or Table I-3 to the TX Cable Loss.

NOTE
Be sure to include the sign of the value. The following examples are included to show the mathematics
and do not represent actual readings:

– Example: 5.65 dBm + 0.55 dBm = 6.20 dBm

– Example: 5.65 dBm + (–0.29 dBm) = 5.36 dBm

– Example: –5.65 dBm + 0.55 dBm = –5.10 dBm

– Example: –5.65 dBm + (–0.29 dBm) = –5.94 dBm

5 Input the Coupler Loss for the TX tests:

– Click Util>Edit>TX Coupler Loss from the menu bar at the main window.

– Input the appropriate coupler loss for the target carrier(s) by referring to the information taken at
the time of BTS installation.

– Click the Save button.

– Click the Dismiss button to close the window.

– To view the coupler loss file, click Util>Examine>TX Coupler Loss.

6 Input the Coupler Loss for the RX tests:

– Click Util>Edit>Cable Loss from the menu bar at the main window.

– Add the appropriate coupler loss to the cable loss for the target carrier(s) by referring to the
information taken at the time of BTS installation and input this value in the Cable Loss field.

– Click the Save button.

– Click the Dismiss button to close the window.

– To view the cable loss file, click Util>Examine>Cable Loss.

7 Have the CBSC operator put the redundant BBX OOS_MANUAL.

! CAUTION
Be sure to download OOS devices only. Loading in–service devices takes them OUT OF SERVICE
and can result in dropped calls.

The code file version numbers must match the version numbers on the other cards in the frame. If the
numbers do not match, the site may go OUT OF SERVICE.

NOTE
Be sure to include the redundant BBX in steps 8, 9, and 10.

. . . continued on next page
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Table I-4: In–Service Calibration

Step Action

8 Download code and data to the target devices:

– Click Util>Tools>Update NextLoad to set the code version that will be downloaded.

– Check the appropriate code version in the pop up window and click the Save button to close.

– Select the target BBX(s) on the C–CCP cage picture.

– Click Device>Download Code to start downloading code.

– Select the target BBX(s) on the C–CCP cage picture.

– Click Device>Download Data to start downloading data.

! CAUTION
Perform the All Cal/Audit procedure on OOS devices only.

9 Run the All Cal/Audit procedure:

– Select the target BBX(s) on the C–CCP cage picture.

– Click Tests>All Cal/Audit from the menu bar at the main window.

– Select the target carrier and confirm the channel number in the pop up window.

– Leave the Verify BLO check box checked and click the OK button to start calibration.

– Follow the on–screen instructions, except, do not connect to the BTS antenna port, connect to the
directional coupler (fwd) port associated with the on screen prompt antenna port.

10 Save the result and download the BLO data to the target BBX(s):

– Click the Save Result button on the result screen.
The window closes automatically.

11 Logout from the BTS and close the LMF session:

– Click Select>Logout to close the BTS connection.

– Close the LMF window.

12 Restore the new “bts–*.cal” file to the CBSC.

13 Enable the target device(s) from the CBSC.
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Notes
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Alarm Connector Location/Pin Numbering SC
4850/4850E, 3-85

ALARM LED, GLI2, 6-23

Alarm Monitor window, 3-84

Alarm Reporting Display, 3-84

All Cal/Audit Test, 3-72, 3-73

All RX, 4-1

All TX, 4-1

All TX/RX, 4-2

AMR, No control, 6-16

AMR CDI Alarm Input Verification, test data sheets,
A-17

Ancillary Equipment Frame identification, 1-13

Ancillary frame, when to optimize, C-1

Antenna Map, 3-80

ATP, 4-1
Code Domain Power, 4-10
Frame Error Rate (FER), 4-12
generate report, 4-13
Pilot Time Offset, 4-9
Report, 4-13
Spectral Purity Transmit Mask, 4-6
test matrix/detailed optimization, C-2
Test Prerequisites, 4-2
Test Procedure, 4-3
testing options, 4-3
Waveform Quality (rho), 4-8

Automated Acceptance Test Procedure, 4-1

B
Backplane DIP switch settings, 2-3

Bay Level Offset calibration failure, 6-6

BBX
Connector, 6-14
gain set point vs BTS output considerations, D-1
No control in the shelf, 6-16

BLO
Calibration, 3-63
Calibration Audit, 3-70
calibration data file, 3-65
Calibration Failure, 6-6
Download, 3-70

BTS
Ethernet LAN interconnect diagram, 3-14
LMF connection, 3-5
system software download, 3-3
test data sheets, redundancy/alarm tests, A-16
when to optimize, C-1
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BTS frame
DC Distribution Pre–test, 2-9
DC Power Pre–test, 2-7
initial power–up, 2-14

Create CAL File, 3-74

C
C–CCP Backplane, Troubleshooting, 6-13, 6-14

C–CCP Shelf, 1-19
Site Serial Number Check List, A-18

Cable
GPIB, 1-9
LAN Cable, 1-10
Calibrating, 3-45, 3-56, 3-57
Null Modem, 3-34
Setting Loss Values, 3-61
Timimg Reference, 1-9

Cable Calibration
HP8921 with HP PCS 
Manual, F-3

CAL File, 3-74

Calculating Center Frequencies
1700 MHz, E-7
1900 MHz, E-2
800 MHz, E-4

Calibrating
Cables, 3-56

RX, 3-59
TX, 3-58

Test Equipment, 3-56

Calibrating Test Cable, Advantest R3465, F-8

Calibration
BLO, 3-63
Cable, 1-6
data file, BLO, 3-65
In–Service, I-13
RF Path, Test Equipment Setup, 3-67
RFDS, 3-82
Test Equipment, 1-6
TX Path, 3-64, 3-68

Test Cable Calibration, 1-6

Test Equipment Calibration, 1-6

Calibration Audit Failure, Troubleshooting, 6-7

Cannot communicate to Communications Analyzer,
6-3

Cannot communicate to Power Meter, 6-2

Cannot download CODE to any device card, 6-4

Cannot Download DATA to any device card, 6-4

Cannot ENABLE device, 6-5

Cannot load BLO, 6-7

Cannot Log into cell–site, 6-2

Cannot perform carrier measurement, 6-9

Cannot perform Code Domain Noise Power
measurement, 6-9

Cannot perform Rho or pilot time offset
measurement, 6-8

Cannot perform Txmask measurement, 6-8

Carrier Measurement Failure, Troubleshooting, 6-9

CDF
site configuration, 3-2
site equipage verification, 3-3
site type and equipage data information, 2-1

CDF Files, Copy from CBSC, 3-8

CDI Alarm
with Alarms Test Box, 3-86
without Alarms Test Box, 3-89

CDMA LMF, Product Description, 1-2

Cell Site
equipage verification, 2-1
preliminary operations, 2-1
types, 3-2

Cell Site Data File. See CDF

Channel elements, No or missing, 6-17

Channels
1700 MHz, E-6
1900 MHz, E-1
800 MHz, E-4

Checksum Failure, 6-11

CIO, Connectors, 6-14

CLI, 1-3, 3-19
Command Line Interface, 3-18
Format Conventions, 3-19
Logging Out, 3-23

Cobra RFDS
external housing, 1-33
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RF connector panel detail, 1-33

Code Domain Power, 4-5
ATP, 4-10

Code Domain Power and Noise Floor Measurement
Failure, Troubleshooting, 6-9

Code Domain Power Test, 4-10

Code Download Failure, Troubleshooting, 6-4

Command Line Interface, 1-3, 3-19

Common power supply verification, 2-13

Communications Analyzer Communication Failure,
Troubleshooting, 6-3

Communications System Analyzer, 1-9
Advantest, 1-9
HP8921A/600, 1-9
CyberTest, 1-9
HP8935 Analyzer, 1-9

Connector Functionality, Backplane,
Troubleshooting, 6-13

Copy CAL files from CDMA LMF to the CBSC, 5-6

Copy CAL Files From Diskette to the CBSC, 5-7

Copy CDF Files from CBSC, 3-8

Copy Files to a Diskette, 5-6

Copy CAL files to the CBSC, 5-7

CSM
Clock Source, 3-28, 3-29
Enable, 3-29
frequency verification, 3-34
functions, 3-32
LEDs, 3-33
MMI terminal connection, illustration, 3-35
Reference Source Configuration Error, 6-11
Troubleshooting, 6-11, 6-12

CyberTest, 3-43

D
Data Download Failure, Troubleshooting, 6-4

DC Power Pre–test
+27 V BTS frame detail, 2-7
–48 V BTS frame detail, 2-9
BTS Frame, 2-5
RFDS, 2-11
RFDS detail, 2-11

DC Power Problems, 6-18

DC/DC Converter, LED Status Combinations, 6-20

Device Enable (INS) Failure, Troubleshooting, 6-5

Digital Control Problems, C–CCP Backplane
Troubleshooting, 6-15

Digital Multimeter, 1-9

Directional Coupler, 1-10

Download
BLO, 3-70
BTS, 3-25
BTS system software, 3-3
MGLI, 3-26
Non–MGLI2 Devices, 3-28
ROM Code, H-1

E
E1, isolate BTS from the E1 spans, 3-4

Enable
CSMs, 3-29
MCCs, 3-31
Redundant GLIs, 3-31

Enabling Devices, 5-2

Equipment setup, VSWR, HP Test Set, G-2

Ethernet LAN
interconnect diagram, 3-14
Transceiver, 1-7

Ethernet maintenance connector interface, illustration,
3-6

F
FER test, 4-12

Folder Structure Overview, 3-13

Frame Error Rate, 4-5
ATP, 4-12

FREQ Monitor Connector, CSM, 6-22

Frequency counter, optional test equipment, 1-10

Frequency Spectrum
Korean PCS (1700 MHz), E-6
North American Cellular Telephone System (800

MHz), E-4
North American PCS (1900 MHz), E-1

Full Optimization, 4-2

G
Gain set point, BBX, D-1
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Generating an ATP Report, 4-13

General optimization checklist, test data sheets, A-4

Gigatronics Power Meter, 3-43

GLI. See Master (MGLI2) and Slave (SGLI2) Group
Line Interface

GLI2
Connector, 6-14
Ethernet Connections, 6-14
LED Status, 6-23
No Control through span line connection, 6-15
No Control via LMF, 6-15

GPIB Cable, 1-9

GPS
Initialization/Verification, 3-36
receiver operation, test data sheets, A-5
satellite system, 3-30
Test Equipment Setup, 3-34

GPS Bad RX Message Type, 6-11

Graphical User Interface, 1-3, 3-18

GUI, 1-3, 3-18
Graphical User Interface, 3-18
Logging Out, 3-22

H
LMF Hardware Requirements, 1-7

High Stability 10 MHz Rubidium Standard, 1-11

High Stability Oscillator, 3-33

High–impedance Conductive Wrist Strap, 1-10

HP 437B, 3-43

HP 83236 A, F-3

HP 83236A, F-2

HP 8921, 3-43

HP 8921A, System Connectivity Test, F-2

HP 8935, 3-43

HP PCS Interface Test Equipment Setup for Manual
Testing, F-7

HP Test Set, VSWR, G-2

HSO, Initialization/Verification, 3-42

HyperTerminal Connection, Creating, 3-10

I
I and Q values, B-1

In–Service Calibration, I-13

Initial Installation of Boards/Modules, preliminary
operations, 2-1

Initial power tests, test data sheets, A-3

Initial power–up
BTS frame, 2-14
RFDS, 2-14

Initialization/Verification
GPS, 3-36
HSO, 3-42
LFR, 3-39

Intended reader profile, 1-12

Inter–frame cabling, when to optimize, C-2

IS–97 specification, B-1

ISB connectors, 6-13

Isolation, T1/E1 Span, 3-4

Itasca Alarms Test Box, 1-11

L
LAN

BTS frame interconnect, illustration, 3-14
Tester, 1-11

LAN Connectors, GLI2, 6-24

LED, CSM, 3-33

LED Status, 6-20
BBX, 6-25
CSM, 6-21
DC/DC Converter, 6-20
GLI2, 6-23
LPA, 6-26
MCC, 6-25

LFR
Initialization / Verification, 3-39
receiver operation, test data sheets, A-6

LFR/HSO, Test Equipment Setup, 3-34

Line Build Out parameters
configure, 5-4
verify, 5-3

LMF, 1-6, 3-7
Ethernet maintenance connector interface detail,

illustration, 3-6
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Installation and Update Procedures, 3-7
Termination and Removal, 5-7
to BTS connection, 3-5

LMF Operation, 3-18

LMF Removal, 5-6

Loading Code, 3-25

Logging In to a BTS, 3-20

Logging Out, 3-22
CLI, 3-23
GUI, 3-22

Logical BTS, 1-13
Numbering, 1-14

Login
CLI, 3-22
GUI, 3-20

Login Failure, Troubleshooting, 6-2

Low Frequency Receiver, 3-33

LPA, test data sheets
convergence, A-8
IM Reduction, A-7

LPA Module LED, 6-26

LPAs, Site Serial Number Check List, A-19

M
Manual

layout, 1-1
overview, 1-2

MASTER LED, GLI2, 6-23

MCC, Enable, 3-31

MGLI2
board detail, MMI port connections, 5-4
Download, 3-26

Miscellaneous errors, Troubleshooting, 6-5

MMI Connection, 3-24

MMI Connector
CSM, 6-22
GLI2, 6-24
MCC, 6-25

MMI equipment setup, 3-24

Model SLN2006A MMI Interface Kit, 1-9

Module status indicators, 6-20

Multi–FER test Failure, Troubleshooting, 6-10

N
NAM, Valid Ranges, 3-79

No DC input voltage to  Power Supply Module, 6-18

No DC voltage +5 +65 or +15 Volts to a specific
GLI2 BBX or Switch board, 6-19

No GPS Reference Source, 6-11

Non–MGLI2, Download, 3-28

Null Modem Cable, 3-34

O
Online Help, 1-3

Optimization
Process, 3-1
purpose, 1-4
When, 1-5

Optional Test Equipment, 1-10
frequency counter, 1-10

Oscilloscope, 1-11

P
PA Shelves, 1-20

path
RX, 1-4
TX, 1-4

PCMCIA, Ethernet adapter, LMF to BTS connection,
3-5

Pilot Gain, 4-8, 4-9, 4-10, 4-12

Pilot Offset Acceptance test, 4-9

Pilot Time Offset, 4-5, 4-9

Pin/Signal Information for ARM A Cable, 3-90

Ping, 3-14

PN Offset
programming information, B-1
usage, B-1

PnMask, I and PnMask Q Values, B-2

Power Conversion Shelf (–48 V BTS Only), Site
Serial Number Check List, A-19

Power Delta Calibration
Advantest, I-4
HP8921A, I-2
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HP8935, I-7

Power Input, 6-13

Power Meter, 1-9

Power Meter Communication Failure,
Troubleshooting, 6-2

Power Supply Module Interface, 6-14

Pre–power tests, test data sheets, A-3

Preliminary operations
cell Site types, 2-1
test data sheets, A-2

Prepare to Leave the Site
external test equipment removal, 5-1
LMF Removal, 5-6
re–connect BTS IFM connector, 5-8
re–connect BTS T1 spans, 5-8
Reestablish OMC–R control, 5-8
Verify T1/E1, 5-8

Pushbuttons and Connectors, GLI2, 6-24

PWR/ALM LED
BBX, 6-25
CSM, 6-21
DC/DC Converter, 6-20
generic, 6-20
MCC, 6-25

R
RDM, 6-13

Re–connect BTS IFM connector, 5-8

Re–connect BTS T1 Spans, 5-8

Redundant GLIs, Enable, 3-31

Reestablish OMC–R control, 5-8

Reference Distribution Module, 6-13

Required documents, 1-12

RESET Pushbutton, GLI2, 6-24

Resetting BTS modules, 5-2

RF
Adapters, 1-10
Attenuators, 1-10
Load, 1-10

RF Path Calibration, 3-67

RFDS
Calibration, 3-82
DC Power Pre–test, 2-11
Description, 3-75
initial power–up, 2-14
Layout, 1-33
Parameter Settings, 3-76
Set Configuration Data, 3-81

rho, 4-5

rho test, 4-8

ROM Code, Download, H-1

RS–232 to GPIB Interface, 1-8

Rubidium Standard Timebase, 3-43

RX, antenna VSWR, test data sheets, A-17

RX Acceptance Tests, Frame Error Rate, 4-5, 4-12

RX path, 1-4

S
Sector Configuration, 1-28

Set Antenna Map Data, 3-80

Set Span Parameter Configuration, procedure, 5-4

Setting Cable Loss Values, 3-61

Setting TX Coupler Loss Value, 3-62

SGLI2, board detail, MMI port connections, 5-4

Shelf Configuration Switch, 2-3

Signal Generator, 3-58, 3-59

Site, equipage verification, 3-3

Site checklist, data sheets, A-2

Site equipage, CDF file, 3-2

Site I/O board, T1 span cable connection, 5-8

Site Serial Number Check List, A-18

Span Framing Format
configure, 5-4
verify, 5-3

Span I/O board
E1 span isolation, illustration, 3-5
T1 span isolation, illustration, 3-5

Span Line
connector , 6-13
T1/E1 Verification Equipment, 1-11

Span line traffic, No or missing, 6-16
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Span Parameter Configuration
set, procedure, 5-4
verification, procedure, 5-3

Span Problems, no control link, 6-27

SPANS LED, GLI2, 6-23

Spectral Purity Transmit Mask ATP, 4-6

Spectral Purity TX Mask, 4-5

Spectrum Analyzer, 1-11, 3-58, 3-59

Spectrum Analyzer , HP8594E, 3-43

STATUS LED, GLI2, 6-23

SYNC Monitor Connector, CSM, 6-22

System Connectivity Test, HP8921A, F-2

T
T1

isolate BTS from the T1 spans, 3-4
span connection, 5-8

Test data sheets
AMR CDI Alarm Input Verification, A-17
BTS redundancy/alarm tests, A-16
general optimization checklist, A-4
GPS receiver operation, A-5
initial power tests, A-3
LFR receiver operation, A-6
LPA

convergence, A-8
IM Reduction, A-7

pre–power tests, A-3
preliminary operations, A-2
RX antenna VSWR, A-17
site checklist, A-2
TX antenna VSWR, A-16
TX BLO

Offset/Power Output Verification, A-9
Power Output Verification, A-14

Test Equipment
Automatically Selecting, 3-55
Calibrating, 3-56
Connecting test equipment to the BTS, 3-43
Manually Selecting, 3-54
Reference Chart, 3-44
Selecting, 3-54
verification data sheets, A-1
VSWR, G-1

Test Equipment Setup, 3-43
GPS & LFR/HSO, 3-34
HP PCS Interface, F-7
RF path  calibration, 3-67

Test Matrix, C-4
ATP optimization, C-2

Test Set, Calibration, 3-53

Timing Reference Cables, 1-9

Top Interconnect Plate, 1-19

Troubleshooting
BBX Control Good – No (or Missing) Span Line

Traffic, 6-16
BLO Calibration Failure, 6-6
C–CCP Backplane, 6-13, 6-14
Calibration Audit Failure, 6-7
Code Domain Power and Noise Floor Measurement

Failure, 6-9
Code Download Failure, 6-4
Communications Analyzer Communication Failure,

6-3
CSM Checklist, 6-11
Data Download Failure, 6-4
DC Power Problems, 6-18
Device Enable (INS) Failure, 6-5
Login Failure, 6-2
MGLI2 Control Good – No Control over AMR,

6-16
MGLI2 Control Good – No Control over

Co–located GLI2, 6-15
Miscellaneous Failures, 6-5
Multi–FER Failure, 6-10
No BBX Control in the Shelf – No Control over

Co–located GLI2s, 6-16
No DC Input Voltage to any C–CCP Shelf Module,

6-19
No DC Input Voltage to Power Supply Module,

6-18
No GLI2 Control through Span Line Connection,

6-15
No GLI2 Control via LMF, 6-15
No MCC Channel Elements, 6-17
Power Meter Communication Failure, 6-2
Rho and Pilot Time Offset Measurement Failure,

6-8
Span Problems, no control link, 6-27
TX and RX Signal Routing, 6-19
TX Mask Measurement Failure, 6-8

TSU NAM
Parameters, 3-78
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Program, 3-83

TX, antenna VSWR, test data sheets, A-16

TX & RX Path Calibration, 3-63

TX and RX Frequency vs Channel
1700 MHz, E-7
1900 MHz, E-2
800 MHz, E-4

TX and RX Signal Routing, C–CCP Backplane
Troubleshooting, 6-19

TX Audit Test, 3-71

TX BLO, test data sheets
Offset/Power Output Verification, A-9
Power Output Verification, A-14

TX Coupler, Setting Loss Value, 3-62

TX Mask test, 4-6

TX Mask Verification, spectrum analyzer display,
illustration, 4-7

TX OUT connection, 4-2

TX Output Acceptance Tests
Code domain power, 4-5, 4-10
introduction, 4-5
Pilot Time Offset, 4-5, 4-9
Spectral purity TX mask, 4-5, 4-6
Waveform quality (rho), 4-5, 4-8

TX Path, calibration, 3-64

TX path, 1-4
audit, 3-71
calibration, 3-68

U
Updating LMF Files, 5-6

UTP, LMF to BTS connection, 3-5

V
Verification of Test Equipment, data sheets, A-1

Verify Span Parameter Configuration, procedure, 5-3

Voltage Standing Wave Ratio. See VSWR

VSWR
Advantest Test Set, G-4
Calculation, G-3, G-5
Equation, G-3, G-5
manual test setup detail

Advantest illustration, G-6
HP illustration, G-3, G-4

required test equipment, G-1
transmit and receive antenna, G-1

W
Walsh channels, 4-10

Warm–up, 1-6

Waveform Quality (rho), 4-5

Waveform Quality (rho) ATP, 4-8

When to optimize
Ancillary – table, C-1
BTS, C-1
inter–frame cabling, C-2

X
Xircom Model PE3–10B2, LMF to BTS connection,

3-5


